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Въведение 

 
Настоящият документ представлява Ръководство за работа с подсистема „Микроданни” 
на Информационна система „Бизнес статистика”.  
ИС „Бизнес статистика” е създадена по поръчка на Националния статистически институт 
с цел автоматизиране на процеса по попълването, валидирането и предаването на 
задължителните годишни отчети на предприятията в Република България. 
 
Чрез модула за въвеждане на отчети потребителите на системата (респонденти, 
счетоводни къщи и служители на НСИ) могат да извършват въвеждане, редактиране, 
валидиране и приключване на годишни отчети: 

 Търсене, визуализиране, разпечатване на годишни отчети: 
 Търсене и извличане на списък на въведени годишни отчети (вкл. и 

за минали години); 
 Визуализиране на екран на справки от отчетите; 
 Разпечатване на справки от отчетите; 
 Възможност за сваляне и съхраняване (записване) на локалния 

персонален компютър на read-only копия от справките от отчетите, за 
нуждите на поддържане на локален архив. 

 Въвеждане и редактиране на годишни отчети: 
 Търсене и извличане на въведени годишни отчети; 
 Въвеждане, редактиране и съхраняване в системата на данните на 

отделните справки от комплекта документи; 
 Валидиране на въведените справки от комплекта документи; 
 Изтриване на въведени справки от комплекта документи. 

 Приключване (обработване) на годишен отчет: 
 Логически контрол и обработване (приключване) на отчет; 
 Сторниране на успешно приключване на отчет (т.е. връщане на отчет 

от приключено в неприключено състояние), последващо редактиране 
и ново приключване на отчета; 

 Анулиране и де-анулиране на отчет. 
 
ИС „Бизнес статистика” е реализирана като централизирана публична Web-базирана 
система, инсталирана и обслужвана от НСИ. Системата е достъпна в Интернет 
пространството през Web-страницата на НСИ и на адрес https://isbs.nsi.bg 
ИС „Бизнес статистика” функционира целогодишно и позволява достъп на външни 
потребители (респонденти и счетоводни къщи) 24 часа в денонощието. Въведените данни 
от отчетите се съхраняват в защитена централизирана база данни, обслужвана от сървъри 
в сградата на НСИ. Системата позволява отчетите да бъдат въвеждани на части и да бъдат 
редактирани многократно до края на съответния срок за подаване на отчети. След края на 
този срок достъпът на респондентите и счетоводните къщи до отчетите е само за четене. 
 

https://isbs.nsi.bg/
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Какво ново в ИС „Бизнес статистика“, версия 2.7 
(2017 год.)? 
 Стандартните версии на браузъра Mozilla Firefox след версия 51 не поддържат 

интеграция с Adobe Reader и затова не може да се ползват за работа със 
системата.  
Специалната версия Mozilla Firefox ESR1 ver.52 ще продължи официално да 
поддържа интеграция с Adobe Reader до м.април 2018 г. Ако желаете да работите 
със системата чрез браузър Mozilla Firefox, използвайте тази версия, която можете 
да свалите от тук: 
https://www.mozilla.org/en-US/firefox/organizations/all/ 

 
Забележка: През м.април 2018 г. ще излезе следващата версия на Mozilla Firefox 
ESR, която вече също няма да поддържа интеграция с Adobe Reader. 

 
 В настоящия документ е добавена инструкция за това как да бъде конфигурирана 

антивирусната програма Avast, ако ползвате такава, така че да се заобиколи 
проблем,  предизвикван от този антивирусен пакет при вход в системата чрез 
цифров сертификат. 

 

                                                 
 

1 ESR = Extended Support Release, т.е. версия с удължена поддръжка. 
Тези версии са предназначени за бизнес-потребители. Производителят на браузъра поддържа 
официално всяка една такава версия за срок от около 1 година (за разлика от стандартните версии, при 
които през около 6 седмици излиза нова версия). 

 

https://www.mozilla.org/en-US/firefox/organizations/all/
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Какво ново в ИС „Бизнес статистика“, версия 2.6 
(2016 год.)? 
 В системата е добавена поддръжка за 4 нови изследвания, за нуждите на online-

подаване и обработване на консолидирани отчети на предприятия: 
 Изследване КОНФ2 (за нефинансови предприятия) 
 Изследване КОЗАС (за застрахователи) 
 Изследване КОИНВ (за инвестиционни предприятия) 
 Изследване КОПОД (за пенсионноосигурителни дружества) 

 Освен чрез цифров сертификат (т.нар. „електронен подпис“) системата 
позволява вече разпознаване на потребителя и вход в системата и чрез ПИК на 
НАП. Тази възможност ще може да се ползва само от обикновени респонденти 
(но не и от потребители, регистрирани в системата като „счетоводни къщи“). 
При вход в системата чрез ПИК на НАП системата ще позволява работа само с 
отчети по изследване НФ1 („Годишни отчети за дейността на нефинансовите 
предприятия, несъставящи баланс“). За останалите типове годишни отчети, вкл. 
и за декларациите за неактивност, е необходимо идентифициране чрез цифров 
сертификат. 

 Системата е конфигурирана да избегне някои сериозни уязвимости на мрежовата 
и информационна сигурност, станали известни в света през последните години. 
В тази връзка, за да работите със системата, е необходимо да сте инсталирали 
всички важни актуализации на Вашата операционна система и Интернет 
браузър (т.е. необходимо е да сте инсталирали всички Security Updates, 
класифицирани като „important”). В противен случай е възможно да имате 
проблем при вход в системата с цифров сертификат (т.нар. „електронен 
подпис“).  

Забележка: ИС „Бизнес статистика“ е тествана и работи коректно (вкл. и с 
цифрови сертификати) дори и на компютри с операционна система 
Windows XP SP3 (Service Pack 3) и браузъри Internet Explorer 7 и Internet 
Explorer 8, за която компанията Microsoft официално прекрати поддръжка 
през м.април 2014 г. Ако имате проблеми, проверете дали имате 
инсталирани всички Windows Security Updates, които са класифицирани 
като „важни“ („important”). 
Ако ползвате компютър с операционна система Windows 7, за да работите 
със системата, трябва да имате инсталиран Windows 7 Service Pack 1 + 
важните Security Updates.  
Ако ползвате компютър с операционна система Windows Vista, за да 
работите със системата, трябва да имате инсталиран Windows Vista Service 
Pack 2 + важните Security Updates. 

 Мрежовият протокол SSLv3 вече не се счита в света за достатъчно надежден от 
гледна точка на мрежова сигурност. Затова в ИС „Бизнес статистика“ вече е 
забранено неговото ползване за нуждите на разпознаване на потребителя чрез 
цифров сертификат и криптиране на комуникацията между Вашия браузър и 
сървърите на системата. Вместо това браузърите трябва да ползват протокол 
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TLS 1.0, TLS 1.1 или TLS 1.2 (наследници на SSLv3). Новите браузъри по 
подразбиране са настроени да ползват тези протоколи. Ако досега сте се 
свързвали без проблеми със сървърите на системата, а вече имате проблем, моля 
прегледайте разделите в настоящия документ, описващи необходимите 
настройки на браузърите. Тези раздели са актуализирани, за да отразят 
необходимите настройки за въпросните мрежови протоколи. 

 Сървърът на ИС „Бизнес статистика“ е с нов цифров сертификат с подобрена 
сигурност на подписа на издателя. Чрез този сертификат сървърът се представя 
пред вашите браузъри, за да имате сигурността, че сте се свързали с истинския 
сървър на системата, а не с негова пиратска имитация. Новите операционни 
системи (като Windows Vista / Windows 7 / 8 / 8.1 / 10) поддържат работа с такива 
сървърни сертификати с подобрена сигурност на подписа. Тези от вас, обаче, 
които все още ползват Windows XP, трябва да проверят дали имат инсталиран 
Service Pack 3 (SP3) на Windows XP, тъй като версиите на Windows XP преди 
SP3 не поддържат работа с такива сървърни сертификати и съответно браузърите 
Internet Explorer 7 и 8 няма да разпознават коректно новия сървърен сертификат 
на ИС „Бизнес статистика“. 

 Браузърът Google Chrome вече не може да се ползва за работа със системата. В 
началото на м.септември 2015 г. компанията Google извърши технически 
промени в браузъра, в резултат на което в него от версия 45 (вкл.) нататък се 
прекратява възможността за интеграция с Adobe Reader и редица други 
софтуерни продукти. Поради това справките в отчетите, които са реализирани 
като PDF-форми, не могат да се отварят в новите версии на Google Chrome. 
Забележка: Браузърът Chromium2 до версия 44 (вкл.) може да се ползва за 
работа със системата, включително и за работа с PDF-формите. 

 Adobe Reader версия 11.0.7 или по-нов (вкл. Adobe Reader DC/2015) при работа с 
браузър Mozilla Firefox предизвиква проблем в някои ситуации, когато PDF-
формите са отвoрени като отделни самостоятелни прозорци. Това е дефект на 
Adobe Reader или Mozilla Firefox, а не на софтуера на потребителското 
приложение на системата. За избягване на този проблем потребителското 
приложение е модифицирано, така че при ползване на Mozilla Firefox да отваря 
PDF-формите като подпрозорци на браузърния прозорец, а не като отделни 
самостоятелни прозорци. (Когато PDF-формите са отворени като подпрозорци 
на браузъра, проблемът не се случва). Ако сте свикнали и желаете да работите с 
PDF-формите като самостоятелни прозорци, можете да ползвате браузъра MS 
Internet Explorer, при който такъв проблем няма и PDF-формите се отварят като 
самостоятелни прозорци. 

 В настоящия документ е добавена подробна инструкция за това как да бъде 
конфигурирана антивирусната програма ESET NOD32, ако ползвате такава, така 
че да се заобиколи проблем,  предизвикван от този антивирусен пакет при вход в 
системата чрез цифров сертификат. 

                                                 
 

2 Chromium е open source версия на Google Chrome, притежава същия външен вид и функционалност. 
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1. Предварителни изисквания и настройки 
За да можете да работите със системата, трябва да разполагате с: 

1) Интернет браузър (един от следните) 3: 
 MS Internet Explorer (версия 7, 8, 9, 10 или 11) 
 Mozilla Firefox ESR, версия 52 (или по-стара) 
 Mozilla Firefox, до версия 51 (вкл.) 

2) Adobe Reader (версия 9 или по-нов) 4 

3) Квалифициран електронен подпис (цифров сертификат) или ПИК на НАП 5, 
чрез който да се идентифицирате пред системата  

 

За работа със системата е необходимо да направите/проверите някои настройки на Вашия 
браузър и Adobe Reader. За целта ползвайте разделите с инструкции по-нататък в 
настоящата глава на документа, които съответстват на модела и версията на Вашия 
браузър и Adobe Reader, а останалите раздели прескочете.  

За подробности относно цифровите сертификати виж раздел 1.33 „Изискване за ползване 
на цифров сертификат”. 

                                                 
 

3 Браузърът MS Edge, който е стандартният браузър в Windows 10, не може да се ползва за работа със 
системата, тъй като не поддържа интеграция с Adobe Reader. Ако работите под Windows 10, ползвайте 
Internet Explorer 11 (който също е наличен стандартно в Windows 10) или инсталирайте и ползвайте 
Mozilla Firefox. 
64-битовите версии на MS Internet Explorer 8 / 9 и на Mozilla Firefox не се поддържат, тъй като Adobe 
Reader не поддържа интеграция с 64-битовите версии на тези браузъри. Вместо това, ако браузърът Ви 
е MS Internet Explorer 8 / 9 или Mozilla Firefox, ползвайте 32-битовата версия на браузъра. (При Internet 
Explorer 10 и 11 няма такъв проблем с 64-битовата му версия). 
Версиите на Mozilla Firefox, които са по-нови от изброените горе, не могат да се ползват за работа със 
системата, тъй като не поддържат интеграция с Adobe Reader. 
С други браузъри, различни от изброените, системата няма да работи коректно. 
 
 
4 Вместо Adobe Reader (версия 9 или по-нов) може да ползвате също Adobe Acrobat (версия 9 или по-
нов), ако разполагате с този продукт.  
Системата няма да работи коректно с друг PDF-продукт (като например Foxit Reader, Nitro PDF 
или вградените PDF-viewer-и в Mozilla Firefox или Google Chrome). 
 
 
5 При идентифициране пред системата чрез ПИК на НАП ще имате възможност за работа само с отчети 
по изследване НФ1 („Нефинансови предприятия, несъставящи баланс“). За всички останали отчети се 
изисква ползване на цифров сертификат (КЕП). 
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1.1 Настройки на браузъра 

Моля, ползвайте само този подраздел по-долу, който съответства на модела и 
версията на Вашия браузър, който ще ползвате за работа със системата, а 
останалите подраздели прескочете. 

1.1.1 Настройки на Microsoft Internet Explorer (на английски) 
1) Уверете се, че в security-настройките на Internet Explorer са включени следните 

опции: 
 В група „ActiveX controls and plug-ins”: 

 Binary and script behaviors: Enabled 
 Run ActiveX controls and plug-ins: Enabled 
 Script ActiveX controls marked safe for scripting: Enabled 

 В група „Downloads”: File download: Enabled 
 В група „Miscellaneous”: Userdata persistence: Enabled 
 В група „Scripting”: Active scripting: Enabled 

  За целта: 
 Влезте в меню Tools > Internet Options... 
 Изберете тематичната страница Security в горния край на диалоговия 

прозорец 
 Изберете security-зоната, в която работи ИС „Бизнес статистика” (по 

подразбиране зоната е Internet, освен ако изрично не сте включили адреса 
isbs.nsi.bg в друга зона); 

 Натиснете бутона Custom Level... 
 Намерете в списъка настройките, изброени по-горе и се уверете, че за 

всички тях е включена опцията Enable.  
2) Уверете се, че сте изключили опцията „Pop-up Blocker”, т.е. трябва да 

разрешите потребителското приложение да отваря допълнителни прозорци в 
браузъра. По подразбиране тази опция е включена. За да я изключите: 
 От меню Tools > Pop-up Blocker изберете Turn off Pop-up Blocker 

или 
 От меню Tools > Pop-up Blocker изберете Pop-up Blocker Settings и 

добавете изключение за адрес isbs.nsi.bg (по този начин ще 
разрешите отваряне на допълнителни прозорци само за ИС „Бизнес 
статистика“, а не за всички сайтове) 

3) Уверете се, че имате включена опция „Use TLS 1.x” в допълнителните 
настройки на браузъра. За целта; 
 Влезте в меню Tools > Internet Options... 
 Изберете тематичната страница Advanced в горния край 
 Потърсете в списъка елементите Use TLS 1.0, Use TLS 1.1 и Use TLS 1.2 и 

включете поне един от тези елементи, ако всичките са изключени; 
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4) Уверете се, че e включена опцията „Use HTTP 1.1” в допълнителните 
настройки на браузъра. За целта: 
 Влезте в меню Tools > Internet Options... 
 Изберете тематичната страница Advanced в горния край 
 Потърсете в списъка елементите Use HTTP 1.1 и Use HTTP 1.1 through 

proxy connections и ги включете, ако са изключени. 
5) Дефинирайте „Банксервиз” АД като доверен Доставчик на удостоверителни 

услуги (ДУУ)6, ако все още не е дефиниран като такъв във Вашия браузър. 
За целта: 
 Извикайте в браузъра URL  

http://www.b-trust.org/web/files/richeditor/filemanager/certificates/CA_certificates/OperCA5AES_DER.cer, 
при което ще се извърши download на оперативния сертификат на услугата 
B-Trust на „Банксервиз” АД, с който се подписват сървърните сертификати, 
издавани от „Банксервиз” (с този сертификат е подписан и сървърният 
сертификат на ИС „Бизнес статистика”); 

 Отворете сертификата, натиснете бутона Install Certificate… и преминете 
през стъпките на Certificate Import Wizard; 

 Извикайте в браузъра URL 
http://www.b-trust.org/web/files/richeditor/filemanager/certificates/CA_certificates/RootCA5_DER.cer, 
при което ще се извърши download на root-сертификата на услугата B-Trust 
на „Банксервиз” АД, чрез който е подписан оперативният сертификат от 
предната стъпка; 

 Отворете сертификата, натиснете бутона Install Certificate… и преминете 
през стъпките на Certificate Import Wizard, като в страницата „Certificate 
Store“ укажете „Place all certificates in the following store” и в полето 
„Certificate Store” укажете „Trusted Root Certification Authorities”.  

В случай, че имате проблеми със системата при работа с браузър MS Internet Explorer, 
въпреки че сте настроили браузъра съгласно нашите инструкции, върнете фабричните 
настройки на браузъра, след което повторете настройката, описана по-горе. Връщане на 
фабричните настройки на браузъра можете на направите по следния начин: 

 Влезте в меню Tools > Internet Options... 
 Изберете тематичната страница Advanced в горния край 
 Натиснете бутона Reset… в долната част на прозореца. 

Важно: 64-битовите версии на MS Internet Explorer 8 и 9 не могат да се ползват за работа със 
системата, тъй като Adobe Reader не поддържа интеграция с тях, поради което не могат да се отварят 
тези справки в отчетите, които са реализирани като PDF-форми. При Internet Explorer 10 и 11 такъв 
проблем няма. 
Затова, ако операционната Ви система е 64-битова и браузърът Ви е MS Internet Explorer 8 или 9, 
ползвайте 32-битовата версия на браузъра, която можете да стартирате от: 

C:\Program Files (x86)\Internet Explorer\iexplore.exe 

                                                 
 
6 Ако не направите това (например, тъй като не желаете да дефинирате „Банксервиз” АД като доверен ДУУ), 
системата ще може да работи, но браузърът Ви няма да е в състояние да проверява идентичността на 
сървъра на ИС „Бизнес статистика” и ще извежда предупредително съобщение при всяко влизане в 
системата. 

http://www.b-trust.org/web/files/richeditor/filemanager/certificates/CA_certificates/OperCA5AES_DER.cer
http://www.b-trust.org/web/files/richeditor/filemanager/certificates/CA_certificates/RootCA5_DER.cer
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1.1.2 Настройки на Microsoft Internet Explorer (на български) 
1) Уверете се, че в security-настройките на Internet Explorer са разрешени следните 

опции: 
 В група „ActiveX контроли и добавки”: 

 Двоични и скриптови поведения: Разрешаване 
 Изпълнявай ActiveX контролите и добавките: Разрешаване 
 Скриптови ActiveX контроли, маркирани като безопасни за 

използване в скриптове: Разрешаване 
 В група „Изтегляния”: Изтегляне на файл: Разрешаване 
 В група „Изготвяне на скрипт”: Активно изготвяне на скрипт: Разрешаване 
 В група „Разни”: Запазване на потребителските данни: Разрешаване 

 За целта: 
 Влезте в меню Инструменти > Опции за интернет 
 Изберете тематичната страница Защита в горния край на диалоговия 

прозорец 
 Изберете security-зоната, в която работи ИС „Бизнес статистика” (по 

подразбиране зоната е Интернет, освен ако изрично не сте включили 
адреса isbs.nsi.bg в друга зона); 

 Натиснете бутона Ниво по избор... 
 Намерете в списъка настройките, изброени по-горе и се уверете, че за 

всички тях е включена опцията Разрешаване.  
2) Уверете се, че сте изключили опцията „Блокиране на изскачащи прозорци”, т.е. 

трябва да разрешите потребителското приложение да отваря допълнителни 
прозорци в браузъра. По подразбиране тази опция е включена. За да я 
изключите, направете едно от следните: 
 От меню Инструменти > Блокиране на изскачащите прозорци изберете 

Изключи блокирането на изскачащи прозорци 
или 

 От меню Инструменти > Блокиране на изскачащите прозорци изберете 
Настройки на блокирането на изскачащи прозорци и добавете 
изключение за адрес isbs.nsi.bg (по този начин ще разрешите 
отваряне на допълнителни прозорци само за ИС „Бизнес статистика“, а не 
за всички сайтове) 

3) Уверете се, че имате включена опция „Използвай TLS 1.x” в допълнителните 
настройки на браузъра. За целта: 
 Влезте в меню Инструменти > Опции за интернет 
 Изберете тематичната страница Разширени в горния край 
 Потърсете в списъка елементите Използвай TLS 1.0, Използвай TLS 1.1 и 

Използвай TLS 1.2 и включете поне един от тези елементи, ако всичките 
са изключени 
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4) Уверете се, че e включена опцията „Използвай HTTP 1.1” в допълнителните 
настройки на браузъра. За целта: 
 Влезте в меню Инструменти > Опции за интернет 
 Изберете тематичната страница Разширени в горния край 
 Потърсете в списъка елементите Използвай HTTP 1.1 и Използвай HTTP 1.1 

през връзки с прокси сървър и ги включете, ако са изключени. 
5) Дефинирайте „Банксервиз” АД като доверен Доставчик на удостоверителни услуги 

(ДУУ)7, ако все още не е дефиниран като такъв във Вашия браузър. 
За целта: 
 Извикайте в браузъра URL  

http://www.b-trust.org/web/files/richeditor/filemanager/certificates/CA_certificates/OperCA5AES_DER.cer, 
при което ще се извърши download на оперативния сертификат на услугата 
B-Trust на „Банксервиз” АД, с който се подписват сървърните сертификати, 
издавани от „Банксервиз” (с този сертификат е подписан и сървърният 
сертификат на ИС „Бизнес статистика”); 

 Отворете сертификата, натиснете бутона Инсталиране на сертификат… и 
преминете през стъпките на Съветник за инсталиране на сертификати; 

 Извикайте в браузъра URL 
http://www.b-trust.org/web/files/richeditor/filemanager/certificates/CA_certificates/RootCA5_DER.cer, 
при което ще се извърши download на root-сертификата на услугата B-Trust на 
„Банксервиз” АД, чрез който е подписан оперативният сертификат от предната 
стъпка; 

 Отворете сертификата, натиснете бутона Инсталиране на сертификат… и 
преминете през стъпките на Съветник за инсталиране на сертификати, 
като в страницата „Хранилище за сертификати“ укажете „Поставяй всички 
сертификати в следното хранилище” и в полето „Хранилище за 
сертификати” укажете „Надеждни главни сертифициращи органи”.  

В случай, че имате проблеми със системата при работа с браузър MS Internet Explorer, 
въпреки че сте настроили браузъра съгласно нашите инструкции, върнете фабричните 
настройки на браузъра, след което повторете настройката, описана по-горе. Връщане на 
фабричните настройки на браузъра можете на направите по следния начин: 

 Влезте в меню Инструменти > Опции за интернет. 
 Изберете тематичната страница Разширени в горния край 
 Натиснете бутона Начално състояние… в долната част на прозореца. 

Важно: 64-битовите версии на MS Internet Explorer 8 и 9 не могат да се ползват за работа със 
системата, тъй като Adobe Reader не поддържа интеграция с тях, поради което не могат да се отварят 
тези справки в отчетите, които са реализирани като PDF-форми. При Internet Explorer 10 и 11 такъв 
проблем няма. 
Затова, ако операционната Ви система е 64-битова и браузърът Ви е MS Internet Explorer 8 или 9, 
ползвайте 32-битовата версия на браузъра, която можете да стартирате от: 

C:\Program Files (x86)\Internet Explorer\iexplore.exe 

                                                 
 
7 Ако не направите това (например, тъй като не желаете да дефинирате „Банксервиз” АД като доверен ДУУ), 
системата ще може да работи, но браузърът Ви няма да е в състояние да проверява идентичността на 
сървъра на ИС „Бизнес статистика” и ще извежда предупредително съобщение при всяко влизане в 
системата. 

http://www.b-trust.org/web/files/richeditor/filemanager/certificates/CA_certificates/OperCA5AES_DER.cer
http://www.b-trust.org/web/files/richeditor/filemanager/certificates/CA_certificates/RootCA5_DER.cer
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1.1.3 Настройки на Mozilla Firefox (на английски) 
1) Уверете се, че сте разрешили изпълнението на JavaScript в браузъра. За целта: 

 В адресния ред на браузъра напишете about:config и натиснете клавиша 
<Enter> 

 Ако бъде изведено предупредително съобщение, натиснете в него бутона 
„I’ll be carefull!”  

 В полето за търсене извършете търсене за javascript.enabled 
 Включете преференцията javascript.enabled, ако е изключена (за целта 

направете десен клик с мишката върху нея и изберете „Togle” или пък 
просто извършете двоен клик с мишката върху преференцията), за да 
стане нейната стойност „true” 

2) Уверете се, че сте изключили опцията „Pop-up Blocker”, т.е. трябва да 
разрешите потребителското приложение да отваря допълнителни прозорци в 
браузъра. По подразбиране тази опция е включена. За целта направете 
следното: 
 Влезте в меню Tools > Options... 
 Изберете тематичната страница Content в горния край 
 Изключете опцията Block pop-up windows 

или 
 От същото място чрез бутона Exceptions добавете изключениe за адрес 

https://isbs.nsi.bg (по този начин ще разрешите отваряне на 
допълнителни прозорци само за ИС „Бизнес статистика“, а не за всички 
сайтове) 

3) Дефинирайте „Банксервиз” АД като доверен Доставчик на удостоверителни 
услуги (ДУУ)8, ако все още не е дефиниран като такъв във Вашия браузър. За 
целта извършете следните действия: 
 Извикайте в Mozilla Firefox URL 

http://www.b-trust.org/web/files/richeditor/filemanager/certificates/CA_certificates/OperCA5AES_DER.cer, 
при което ще се извърши download на оперативния сертификат на услугата 
B-Trust на „Банксервиз” АД, с който се подписват сървърните сертификати, 
издавани от „Банксервиз” АД (с този сертификат е подписан и сървърният 
сертификат на ИС „Бизнес статистика”); 

 Отворете сертификата в Mozilla Firefox, задайте предназначението му 
както е показано на долната картинка и натиснете бутона „OK”: 

 

                                                 
 
8 Ако не направите това (например, тъй като не желаете да дефинирате „Банксервиз” АД като доверен ДУУ), 
системата ще може да работи, но браузърът Ви няма да е в състояние да проверява идентичността на 
сървъра на ИС „Бизнес статистика” и ще извежда предупредително съобщение при всяко влизане в 
системата. 

http://www.b-trust.org/web/files/richeditor/filemanager/certificates/CA_certificates/OperCA5AES_DER.cer
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Фиг. 1 Дефиниране на „Банксервиз” АД в Mozilla Firefox 
като доверен удостоверител на сървърни сертификати 

4) Настройте браузъра да отваря PDF-документите чрез Adobe Reader (или Adobe 
Acrobat) вътре в екран на браузъра, а не във външен прозорец. За целта: 
 Влезте в меню Tools > Options... 
 Изберете тематичната страница Applications в горния край; 
 За типа „Portable Document Format (PDF)” и за типовете, съдържащи в 

името си „Adobe Acrobat“, задайте „Use Adobe Acrobat (In Firefox)”: 

 
Фиг. 2 Настройване на PDF-документите да се отварят от Adobe Reader вътре в Mozilla Firefox 

Важно: 64-битовите версии на Mozilla Firefox не могат да бъдат ползвани за работа със 
системата, тъй като не позволяват интеграция с Adobe Reader. Затова ползвайте 32-битова 
версия на Mozilla Firefox. 
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1.1.4 Настройки на Mozilla Firefox (на български) 
1) Уверете се, че сте разрешили изпълнението на JavaScript в браузъра. За целта: 

 В адресния ред напишете about:config и натиснете клавиша <Enter> 
 Ако бъде изведено предупредително съобщение, натиснете в него бутона 

„Ще бъда внимателен, обещавам!”  
 В полето за търсене извършете търсене за javascript.enabled 
 Включете преференцията javascript.enabled, ако е изключена (за целта 

направете десен клик с мишката върху нея и изберете „Превключване” 
или пък просто извършете двоен клик с мишката върху преференцията), 
за да стане нейната стойност „true” 

2) Уверете се, че сте изключили опцията „Блокиране на изскачащи прозорци”, т.е. 
трябва да разрешите потребителското приложение да отваря допълнителни 
прозорци. По подразбиране тази опция е включена. За целта направете 
следното: 
 Влезте в меню Инструменти > Настройки... 
 Изберете тематичната страница Съдържание в горния край 
 Изключете опцията Блокиране на изскачащи прозорци 

или 
 От същото място чрез бутона Изключения добавете изключениe за адрес 

https://isbs.nsi.bg (по този начин ще разрешите отваряне на 
допълнителни прозорци само за ИС „Бизнес статистика“, а не за всички 
сайтове) 

3) Дефинирайте „Банксервиз” АД като доверен Доставчик на удостоверителни 
услуги (ДУУ)9, ако все още не е дефиниран като такъв във Вашия браузър. За 
целта извършете следните действия: 
 Извикайте в Mozilla Firefox URL 

http://www.b-trust.org/web/files/richeditor/filemanager/certificates/CA_certificates/OperCA5AES_DER.cer, 
при което ще се извърши download на оперативния сертификат на услугата 
B-Trust на „Банксервиз” АД, с който се подписват сървърните сертификати, 
издавани от „Банксервиз” АД (с този сертификат е подписан и сървърният 
сертификат на ИС „Бизнес статистика”); 

 Отворете сертификата в Mozilla Firefox, задайте предназначението му 
както е показано на долната картинка и натиснете бутона „Добре”: 

 

                                                 
 
9 Ако не направите това (например, тъй като не желаете да дефинирате „Банксервиз” АД като доверен ДУУ), 
системата ще може да работи, но браузърът Ви няма да е в състояние да проверява идентичността на 
сървъра на ИС „Бизнес статистика” и ще извежда предупредително съобщение при всяко влизане в 
системата. 

http://www.b-trust.org/web/files/richeditor/filemanager/certificates/CA_certificates/OperCA5AES_DER.cer
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Фиг. 3 Дефиниране на „Банксервиз” АД в Mozilla Firefox 
като доверен удостоверител на сървърни сертификати 

4) Настройте браузъра да отваря PDF-документите чрез Adobe Reader (или Adobe 
Acrobat) интегриран с браузъра, в прозорец на браузъра, а не като независимо 
външно приложение извън контекста на браузъра. За целта: 
 Влезте в меню Инструменти > Настройки... 
 Изберете тематичната страница Приложения в горния край; 
 За типа „Преносим формат за документи (PDF)” и за типовете, 

съдържащи в името си „Adobe Acrobat“, задайте „Използване на Adobe 
Acrobat (в Firefox)”: 

 
Фиг. 4 Настройване на PDF-документите да се отварят от Adobe Reader вътре в Mozilla Firefox 

Важно: 64-битовите версии на Mozilla Firefox не могат да бъдат ползвани за работа със 
системата, тъй като не позволяват интеграция с Adobe Reader. Затова ползвайте 32-битова 
версия на Mozilla Firefox. 
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1.2 Настройки на Adobe Reader 

Моля, ползвайте само този подраздел по-долу, който съответства на версията на 
Вашия Adobe Reader, а останалите подраздели прескочете. 

1.2.1 Настройки на Adobe Reader XI и Adobe Reader DC 
1) Уверете се, че сте разрешили изпълнението на JavaScript в PDF-форми. За 

целта: 
 Влезте в меню Edit > Preferences… на Adobe Reader 
 Изберете JavaScript в списъка в лявата част на диалоговия прозорец  
 Уверете се, че е включена опцията Enable Acrobat JavaScript най-отгоре в 

десния панел. 
 

 
Фиг. 5 Разрешаване на ползване на Javascript в Adobe Reader XI 

Забележка: Ако тази опция е изключена, при първото отваряне на справка от 
отчета, която е разработена като PDF-форма, ще се визуализира съобщение, че 
документът съдържа програмен код, без който няма да се обработи коректно 
електронната форма. В съобщението се съдържа въпрос дали желаете да позволите 
изпълнението на JavaScript. Изберете отговор „Yes”. 
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2) Ако ползвате Enhanced Security в Adobe Reader (т.е. ако е включена опцията 
„Enable Enhanced Security”), добавете адрес isbs.nsi.bg в списъка на 
Privileged Locations, в противен случай PDF-формите на справките в отчетите 
няма да работят. За целта: 
 Влезте в меню Edit > Preferences...  на Adobe Reader 
 Изберете Security (Enhanced) в списъка в лявата част на прозореца  
 Натиснете бутона Add Host и в отворения диалогов въведете и добавете 

адреса  isbs.nsi.bg 
 

 
Фиг. 6 Дефиниране на isbs.nsi.bg като Privileged Location 
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3) За да можете да съхранявате (копирате) въведените PDF-справки локално на 
Вашия компютър, се уверете, че е изключен т.нар. Protected Mode в Adobe 
Reader. За целта: 
 Влезте в меню Edit > Preferences...  на Adobe Reader 
 Изберете Security (Enhanced) в списъка в лявата част на прозореца  
 Уверете се, че е изключена опцията “Enable Protected Mode at startup” 

 
Фиг. 7 Изключване на Protected Mode в Adobe Reader XI 

Забележка: Опцията “Еnable Protected Mode at startup“ e нова опция в Adobe 
Reader X, която по подразбиране е включена. Ако не се изключи, ще имате 
проблеми при опит за локално съхраняване (копиране) на PDF-справките и 
данните в тях чрез натискане на бутона Save в Adobe Reader. 

Важно: Ако вместо Adobe Reader (или Adobe Acrobat) ползвате друг PDF viewer (като 
например Foxit Reader), системата няма да работи коректно. Затова, ако заедно с Adobe 
Reader (или Adobe Acrobat) имате инсталиран и друг PDF viewer, трябва да настроите 
компютъра си така, че PDF-бланките да се отварят в Интернет браузъра чрез Adobe Reader 
(или Adobe Acrobat), а не чрез другия PDF viewer! 
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1.2.2 Настройки на Adobe Reader X 
1) Уверете се, че сте разрешили изпълнението на JavaScript в PDF-форми. За 

целта: 
 Влезте в меню Edit > Preferences...  на Adobe Reader 
 Изберете JavaScript в списъка в лявата част на диалоговия прозорец  
 Уверете се, че е включена опцията Enable Acrobat JavaScript най-отгоре в 

десния панел. 
 

 
Фиг. 8 Разрешаване на ползване на Javascript в Adobe Reader X 

Забележка: Ако тази опция е изключена, при първото отваряне на справка от 
отчета, която е разработена като PDF-форма, ще се визуализира съобщение, че 
документът съдържа програмен код, без който няма да се обработи коректно 
електронната форма. В съобщението се съдържа въпрос дали желаете да позволите 
изпълнението на JavaScript. Изберете отговор „Yes”. 
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2) Ако ползвате Enhanced Security в Adobe Reader (т.е. ако е включена опцията 
„Enable Enhanced Security”), добавете адрес isbs.nsi.bg в списъка на 
Privileged Locations, в противен случай PDF-формите на справките в отчетите 
няма да работят. За целта: 
 Влезте в меню Edit > Preferences...  на Adobe Reader 
 Изберете Security (Enhanced) в списъка в лявата част на прозореца  
 Натиснете бутона Add Host и в отворения диалогов процорец въведете и 

добавете адреса  isbs.nsi.bg 

 
Фиг. 9 Дефиниране на isbs.nsi.bg като Privileged Location 
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3) За да можете да съхранявате (копирате) въведените PDF-справки локално на 
Вашия компютър, се уверете, че е изключен т.нар. Protected Mode в Adobe 
Reader. За целта: 
 Влезте в меню Edit > Preferences...  на Adobe Reader 
 Изберете General в списъка в лявата част на прозореца  
 Уверете се, че е изключена опцията “Enable Protected Mode at startup” 

 
Фиг. 10 Изключване на Protected Mode в Adobe Reader X 

Забележка: Опцията “Еnable Protected Mode at startup“ e нова опция в Adobe 
Reader X, която по подразбиране е включена. Ако не се изключи, ще имате 
проблеми при опит за локално съхраняване (копиране) на PDF-справките и 
данните в тях чрез натискане на бутона Save в Adobe Reader. 

Важно: Ако вместо Adobe Reader (или Adobe Acrobat) ползвате друг PDF viewer (като 
например Foxit Reader), системата няма да работи коректно. Затова, ако заедно с Adobe 
Reader (или Adobe Acrobat) имате инсталиран и друг PDF viewer, трябва да настроите 
компютъра си така, че PDF-бланките да се отварят в Интернет браузъра чрез Adobe Reader 
(или Adobe Acrobat), а не чрез другия PDF viewer! 
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1.3 Изискване за ползване на цифров сертификат 

Ако сте респондент или счетоводна къща, за да работите със системата, е необходимо да 
ползвате електронен подпис (цифров сертификат), чрез който да се идентифицирате пред 
системата. За целта трябва да притежавате валиден електронен подпис от някой от 
следните видове, издаден от изброените по-долу лицензирани доставчици на 
удостоверителни услуги (ДУУ) в България: 

1. ДУУ „Информационно обслужване” АД:  
 StampIT DocPro  
 StampIT Doc (за лица със свободни професии)  

2. ДУУ „Банксервиз” АД:  
 B-Trust Professional QES  
 B-Trust Personal QES (за лица със свободни професии)  
 B-Trust Professional UES  
 B-Trust Personal UES (за лица със свободни професии)  

3. ДУУ „Инфонотари” ЕАД:  
 i-Notary Company Q Sign  
 i-Notary Personal Q Sign (за лица със свободни професии)  

4. „Евротръст Технолъджис” АД: 
 Evrotrust Qualified Natural Person Certificate 

5. ДУУ „Спектър” АД: 
 Spektar Org Qualified Certificate 
 Spektar Personal Qualified Certificate (за лица със свободни професии) 
 Spektar Org Restricted Universal Certificate  
 Spektar Org Universal Certificate  
 Spektar Personal Restricted Universal Certificate (за лица със свободни 

професии)  
 Spektar Personal Universal Certificate (за лица със свободни професии) 

6. ДУУ „СЕП България” АД: 
 SEP Qualified Organization 
 SEP Qualified Private 

 
Забележка: В настоящия документ не са включени инструкции за инсталиране и 
конфигуриране на сертификатите във Вашите компютри. За подробности относно 
инсталиране на хардуер, на който се съхраняват сертификатът и частният Ви ключ 
(например карточетящо устройство или  USB устройство) и интегрирането им с Вашия 
Интернет браузър се консултирайте с документацията, предоставена Ви от Доставчика на 
удостоверителни услуги, издал Вашия сертификат. 
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1.4 Настройки на антивирусната програма 

Поради дефекти в реализацията на някои антивирусни програми те създават проблеми 
при работа с ИСБС, когато се опитват да прихванат и анализират Web-трафика от/към 
системата. По-долу ще намерите инструкции как да конфигурирате тези антивирусни 
програми, така че да не възпрепятстват работата на ИСБС. 
 

1.4.1 Настройки на антивирусна програма Avast Antivirus 
N.B. Ако не ползвате антивирусен софтуер Avast Antivirus, можете да прескочите 
тази секция, тъй като тя няма отношение към Вас. 
Актуализацията на антивирусния софтуер Avast от 30.3.2017 г. създава проблем при вход 
в системата с цифров сертификат (КЕП) при браузър MS Internet Explorer. Проблемът 
видимо се изразява в това, че след натискане на бутона „Вход“ не се случва нищо (т.е. 
браузърът не извежда прозореца за избор на цифров сертификат и въвеждане на PIN-код). 
За да разрешите проблема, е необходимо да конфигурирате Avast да не инспектира Web-
трафика от/към ИСБС. За целта трябва в Avast да добавите адреса на ИСБС като 
изключение (exclusion). За целта изпълнете следните стъпки, описани по-долу: 

1) Отворете контролния панел на Avast и в него изберете: 
Settings > Components > Web Shield: Customize 
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2) В диалоговия прозорец, който ще се отвори: 
a. Изберете Exclusions 
b. Включете отметката „URLs to exclude” (ако не е включена) 
c. В полето под отметката добавете адрес  https://isbs.nsi.bg* 
d. Натиснете бутона Add 
e. Натиснете бутона ОК 
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Забележка: 
Ако все още ползвате Windows XP с Internet Explorer, то поради друг дефект в Avast 
Antivirus горната процедура може да няма ефект. В такъв случай е необходимо да 
конфигурирате Avast изобщо да не инспектира Web-трафика по протокол HTTPS. За 
целта изпълнете следните стъпки, описани по-долу: 

1) Отворете контролния панел на Avast и в него изберете: 
Settings > Components > Web Shield: Customize 

2) В диалоговия прозорец, който ще се отвори: 
a. Изберете Main Settings 
b. Изключете отметката „Enable HTTPS Scanning” 
c. Натиснете бутона OK 
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1.4.2 Настройки на антивирусна програма ESET NOD32 
N.B. Ако не ползвате антивирусен софтуер ESET NOD32, можете да прескочите 
тази секция, тъй като тя няма отношение към Вас. 
 
Антивирусният софтуер ESET NOD32 не извършва по коректен начин инспектиране и 
филтриране на Web-трафика по протокол SSL/TLS (когато е конфигуриран да извършва 
такова инспектиране/филтриране). Поради тази причина при някои от настройките си 
NOD32 създава проблем, изразяващ се в невъзможност за вход в системата чрез цифров 
сертификат. Това не е проблем в софтуера на ИС „Бизнес статистика“, а се дължи на 
некоректна реализация на сканирането на трафика в NOD32. 
За да бъде избегнат този проблем, ако ползвате антивирусен софтуер NOD32, който е 
настроен да инспектира трафика по протоколи SSL/TLS, е необходимо да добавите в 
настройките на NOD32 изключение, така че NOD32 да не извършва сканиране на Web-
трафика към/от адреса на ИСБС (адрес isbs.nsi.bg). За целта изпълнете инструкциите 
в подсекциите по-долу в зависимост от Вашата версия на NOD32: 
 

1.4.2.1 Настройки на NOD32, версия 9 

За да избегнете проблема, създаван от NOD32 вер.9, е необходимо да добавите цифровия 
сертификат на сървъра на ИСБС към списъка на сертификатите, които NOD32 разпознава 
като „добре известни“ („known certificates”) и да укажете Web-трафика по протокол 
SSL/TLS към/от сървъра на този сертификат да не бъде инспектиран и филтриран. 
 
За целта изпълнете следните стъпки, описани по-долу: 
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1) Отворете контролния панел на NOD32, изберете „Setup”, след това влезте в 
„Internet protection”: 

 
 

2) Влезте в „Web access protection”: 
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3) Кликнете вляво върху „WEB AND EMAIL”, след което отворете „SSL/TLS”: 
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4) Отворете списъка на „добре известните“ сертификати („List of known 
certificates”): 

 
 

5) Ако в списъка вече фигурира сертификат с име „isbs.nsi.bg”, го изтрийте, тъй 
като може да става въпрос за стар сертификат на ИСБС, а не за актуалния 
сървърен сертификат на системата; 

6) Натиснете бутона „Add”, за да добавите и конфигурирате сървърния сертификат 
на ИСБС: 
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7) В екрана, който ще се отвори, натиснете бутона „URL”: 
 

 
 

8) В диалоговия прозорец, който ще се отвори, въведете адрес 
https://isbs.nsi.bg  и натиснете бутона „ОК“: 
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9) Антивирусната програма ще Ви върне в предишния прозорец, където ще е 
изчела и заредила сървърния сертификат на ИСБС. Задайте там Access Action: 
„Allow (even if untrusted)” и Scan action: „Ignore”, след което натиснете бутона 
„OK”: 

 

 
 

Забележка: Най-важната стъпка в този прозорец е указването на Scan action: „Ignore”, чрез 
което ще добавите изключение, инструктиращо NOD32 да не инспектира/филтрира 
трафика по протоколи SSL/TLS към/от сървъра на ИСБС. 
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10) Програмата ще Ви върне в предишния прозорец, където в списъка на 
сертификатите вече трябва да фигурира сървърния сертификат на ИСБС. 
Стойността в полето „Scan” трябва да бъде „Ignore”. Потвърдете извършените 
промени в конфигурацията чрез натискане на бутоните „OK” в този и в 
предишния прозорец, в които програмата ще Ви върне: 

 

 
 

 

 

 
 

 



Информационна система „Бизнес статистика” 
 
РЪКОВОДСТВО ЗА ПОТРЕБИТЕЛЯ Национален Статистически Институт 

 

 

 30 

1.4.2.2 Настройки на NOD32, версия 8 

За да избегнете проблема, създаван от NOD32 вер.8, е необходимо да конфигурирате 
NOD32 да поддържа „сертификати-изключения“ при инспектиране на трафика по 
протокол SSL/TLS и да добавите цифровия сертификат на сървъра на ИСБС към списъка 
на сертификатите-изключения (т.е. „excluded certificates” в терминологията на NOD32), за 
които NOD32 няма да инспектира/филтрира трафика по протоколи SSL/TLS към/от тези 
сървъри. 
N.B. Необходимата конфигурация и проверка на конфигурацията, която трябва да 
направите в NOD32 вер.8 е малко по-сложна отколкото в NOD32 вер.9 поради 
липсата на възможност в контролния панел на NOD32 вер.8 ръчно да добавите 
въпросния сертификат като изключение. Ако проверките и конфирацията, които са 
описани по-долу, Ви се струват сложни и/или неясни, се обърнете към компютърен 
специалист, който да ги извърши.  
 
Добавянето на сертификата като изключение в тази версия на NOD32 можете да 
направите само когато самият NOD32 вер.8 сам Ви запита какво да прави с трафика към 
този сървър. Запитването, което NOD32 извежда в подобен случай при опит за достъп до 
ИСБС (т.е. до адрес http://isbs.nsi.bg), изглежда по следния начин:  
 

 
 
Когато NOD32 изведе такова запитване към Вас, трябва да изберете и натиснете бутона 
„Exclude”, чрез което ще добавите сървърния сертификат на ИСБС като изключение, след 
което NOD32 вер.8 няма повече да инспектира/филтрира трафика по протоколи SSL/TSL 
към/от ИСБС и Вие ще можете да извършвате вход в системата чрез цифров сертификат. 
Ако, обаче, сървърният сертификат на ИСБС бъде разпознат от NOD32 като „доверен“ 
(“trusted”), то тогава NOD32 няма да Ви изведе това предупреждение/запитване и Вие 
съответно няма да имате възможност да маркирате сертификата като „изключение“. В 
този случай, за да добавите сертификата като „изключение“, трябва първо да направите 
така, че NOD32 да не го разпознае като „доверен“. 
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NOD32 счита, че сертификатът е „доверен“ (и няма да ви запита и позволи да бъде 
добавен като изключение), ако вече сте добавили/конфигурирали на компютъра си 
удостоверителната  верига от сертификати на „Банксервиз“ АД (съгласно инструкциите в 
настоящата документация) или пък ако сървърният сертификат на ИСБС вече е бил 
изрично конфигуриран като „доверен“ в NOD32. 
Забележка: Проверката дали удостоверителната верига на „Банксервиз“ АД вече е 
добавена, както и евентуалното нейно временно премахване, можете да извършите 
чрез стандартните средства на Windows и браузърите за конфигуриране на цифрови 
сертификати. Описване на стъпките и начина за извършване на това е извън 
обхвата на настоящата документация.  
 
За да конфигурирате NOD32 да поддържа сертификати-изключения и да проверите дали 
сървърния сертификат на ИСБС не е конфигуриран като „доверен“ в NOD32, след което 
да го изтриете от този списък, ако е, трябва да извършите следната последователност от 
действия: 
 

1) Отворете контролния панел на NOD32, изберете „Setup”, след това влезте в 
„Web and email”: 
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2) Влезте в “Web access protection”: 

 
 

3) В диалоговия прозорец, който ще се отвори, изберете „Protocol filtering”, след 
което „SSL”. В екрана вдясно включете отметката „Apply created exceptions 
based on credentials”, ако тя е изключена: 
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Забележка: Чрез включване на отметката „Apply created exceptions based on credentials” 
Вие инструктирате NOD32 да поддържа и обработва сертификати-изключения. Ако 
отметката не бъде включена, при извеждане на запитване от NOD32 какво да прави със 
сертификата на isbs.nsi.bg (виж първата страница от настоящата секция на този 
документ по-горе) няма да бъде активен бутонът „Exclude” и съответно няма да можете да 
маркирате/добавите сертификата като изключение. 
 

4) Навигирайте в подсекцията „Trusted certificates”, за да проверите дали 
сертификатът на ИСБС не е бил случайно добавен вече като „доверен“. Ако в 
тази секция има сертификат с име „isbs.nsi.bg”, го маркирайте и изтрийте чрез 
бутона „Remove”: 

 

 
 

5) Потвърдете направените промени в конфигурацията чрез натискане на бутоните 
„OK” в този и предишните прозорци на контролния панел на NOD32; 

 
6) След извършване на тези настройки отворете отново в браузъра началната 

страница на ИСБС (адрес https://isbs.nsi.bg). Когато NOD32 изведе 
запитване как да третира „непроверения“ сертификат на ИСБС, натиснете 
бутона „Exclude”:  
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Забележка: По този начин ще дефинирате сървърния сертификат на ИСБС като 
„изключение“, след което NOD32 вече няма да инспектира Web-трафика към/от ИСБС и 
съответно няма да създава проблем, когато извършвате вход в системата чрез цифров 
сертификат. 

 
След като вече сте извършили необходимите настройки, можете лесно да проверите дали 
сървърния сертификат на ИСБС вече е добавен като „изключение“. Ако сте го добавили, 
той трябва да е наличен в секцията „Excluded certificates” на контролния панел на NOD32: 
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2. Стартиране и вход в системата 
ИС „Бизнес статистика” може да бъде достъпена през Web-сайта на Националния 
статистически институт, където има поставена съответна препратка (link) към модула за 
въвеждане/редактиране на отчети. 
ИС „Бизнес статистика” може също така да бъде достъпена в Интернет браузър чрез 
задаване на Интернет адрес https://isbs.nsi.bg 
Внимание: Обърнете внимание, че протоколът в адреса трябва да бъде HTTPS, а не 
HTTP. Чрез използване на протокола HTTPS комуникацията между Вашата работна 
станция и централния сървър на системата в НСИ се криптира и информацията не може 
да бъде прихваната и разчетена от недоброжелателни лица при нейното преминаване през 
публичното Интернет пространство между работната станция и сървъра. 
 
При достъп до входната точка на ИСБС се отваря началната страница на системата, 
където можете да се регистрирате като потребител (ако все още не сте регистрирани) и да 
извършите вход в системата, като се идентифицирате чрез цифров сертификат или ПИК 
на НАП (виж по-долу). 
 
Забележка: При първото стартиране на системата компютърът Ви автоматично изтегля 
голям обем служебни файлове, поради което в зависимост от скоростта на вашия 
Интернет е възможно да се наложи да изчакате известно време (между няколко секунди и 
1 минута). При първото стартиране на всяка от страниците на системата, както и при 
първото отваряне на отделните PDF-форми също може да има малко забавяне в 
зависимост от скоростта на вашия Интернет. 
Забележка: Ако имате настроена опция за автоматично изтриване на кеша на вашия 
Интернет браузър, то при всяко стартиране на системата, при стартиране на отделните 
страници за първи път, както и при отваряне на PDF-формите ще трябва да изчакате 
браузъра да изтегли в кеша си необходимите файлове. 
 
Ако след стартиране на системата не се ориентирате интуитивно как да ползвате 
компонентите от потребителския интерфейс (полета, бутони, списъци за избор, диалогови 
прозорци, PDF-форми и т.н.), тогава първо прочетете глава 11. „Приложение: 
Потребителски интерфейс” в края на този документ. Ако пък се ориентирате добре в 
работата с компонентите от потребителския интерфейс, тогава можете да преминете 
директно към следващата глава на настоящия документ. 
 

https://isbs.nsi.bg/


Информационна система „Бизнес статистика” 
 
РЪКОВОДСТВО ЗА ПОТРЕБИТЕЛЯ Национален Статистически Институт 

 

 

 36 

2.1 Начална страница 

 
Фиг. 11 Изглед на началната страница 

Началната страница се състои от следните секции: 
 Секция за „Вход” на регистриран потребител; 
 Секция за „Регистрация” на нов потребител; 
 Секция „Поддръжка” с информация за адресите за контакт с НСИ по технически 

и методологически въпроси или проблеми; 
 Секция „Предназначение на системата”. 
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Чрез бутона  можете да извършите вход в системата чрез квалифициран 
електронен подпис (цифров сертификат). Необходимо е вече да сте се регистрирали като 
потребител на системата и да разполагате с КЕП от поддържаните от системата видове. 
Системата ще изиска от Вас да представите своя цифров сертификат, след което ще Ви 
прехвърли в страница „Работа с отчети”. В случай, че все още нямате регистриран профил 
на потребител или цифровият Ви сертификат не е от поддържаните от системата видове, 
системата ще Ви информира за това и няма да Ви позволи да влезете в страницата за 
работа с отчети. 

Чрез бутона  можете да извършите вход в системата чрез персонален 
идентификационен код (ПИК) на НАП. Необходимо е вече да сте се регистрирали като 
потребител на системата и да разполагате с ПИК на НАП. Системата позволява вход чрез 
ПИК на НАП само на обикновени респонденти (но не и на потребители, регистрирани 
като „счетоводни къщи“). При натискане на бутона системата ще Ви препрати към 
страница в системата на НАП, където да се представите чрез своя ЕГН/ЛНЧ/ЕИК и ПИК. 
Ако системата на НАП ви разпознае успешно, тя ше Ви прехвърли обратно в страница 
„Работа с отчети” на ИСБС. В случай, че все още нямате регистриран профил на 
потребител в ИСБС или сте регистрирани в ИСБС като „счетоводна къща“, системата ще 
Ви информира за това и няма да Ви позволи да влезете в страницата за работа с отчети. 

Чрез бутона  системата ви препраща към страница „Регистрация на 
потребител”, в която можете да въведете своите идентификационни данни и да се 
регистрирате като потребител на системата, ако все още не сте се регистрирали.  
В секция  „Поддръжка” можете да използвате посочените e-mail адреси, за да изпратите 
запитване или сигнал за проблем от технически или методологически характер към 
служителите на НСИ. 
В секцията „Предназначение на системата” можете да намерите няколко полезни 
препратки: 

1) Препратки за изтегляне на файлове в PDF формат на пълните комплекти на 
хартиените формуляри на актуалните изследвания, поддържани от системата: 

Забележка: Файловете от тези препратки могат да се използват единствено за 
попълване на хартиен носител след разпечатването им. Тези комплекти НЕ са 
електронни форми за попълване в режим off-line. Попълване на отчети в 
електронен вид може да се извършва само в режим on-line чрез настоящия 
модул за въвеждане на отчети. 

2) Препратки за изтегляне на някой от изискваните софтуерни продукти, 
необходими за работат със системата системата; 

В долната част на страница можете да използвате препратката към сайта на НСИ, както 
и препратката за отваряне на настоящия документ. 
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2.2 Регистриране на потребител 

Системата допуска до защитените ресурси (в частност до данни от въведени отчети) само 
регистрирани потребители, които са успешно разпознати. Разпознаването на външните 
потребители се извършва на чрез техен валиден цифров сертификат (КЕП) или чрез ПИК 
на НАП, а на служителите на НСИ – чрез системно име и парола.   
Чрез страницата „Регистрация на потребител” новите външни потребители, които все още 
нямат регистриран профил в системата, си създават профил. С помощта на тази страница 
се саморегистрират всички външни потребители на системата, ползващи системата през 
публичния Интернет.  

Важно: Под понятието „външен потребител” се разбира респондент или 
счетоводна къща. Ако във Вашето предприятие има повече от един служител, 
който ще работи със системата, НЕ трябва да се опитвате да регистрирате като 
отделни потребители тези служители. Всичките служители трябва да ползват 
валиден сертификат за работа със системата. 

 
Страницата за саморегистрация на потребител се зарежда след натискането на бутона 
„Регистрация” в началната страница. При зареждането ѝ страницата се отваря с празни 
полета, в които последователно отгоре надолу трябва да се попълнят данни във всички 
полета: 

 
Фиг. 12 Изглед на страницата "Регистрация на потребител" 
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Последователно въведете данни в следните полета: 
1) Ако все още не сте се идентифицирали (представили) пред сървъра на 

системата чрез цифров сертификат, полето „Идентификатор на потребителя“ ще 
бъде достъпно за ръчно въвеждане, като трябва в него да въведенет Вашия ЕИК 
по ТР/БУЛСТАТ, ЕГН/ЛНЧ или служебен номер от НАП, който ще бъде 
използван в ролята на потребителско име в системата. 

Внимание: Не въвеждайте чужд ЕИК, ЕГН или ЛНЧ, тъй като не 
разполагате с цифров сертификат или ПИК от НАП за този ЕИК, ЕГН или 
ЛНЧ и съответно няма да можете да извършите вход в системата по-късно с 
този потребителски идентификатор. 

2) Ако вече сте се идентифицирали (представили) пред сървъра на системата чрез 
цифров сертификат, полето „Идентификатор на потребителя” ще бъде 
автоматично попълнено с ЕИК по ТР/БУЛСТАТ или ЕГН/ЛНЧ, извлечен от 
Вашият валиден цифров сертификат. В такъв случай полето няма да е достъпно 
за ръчно попълване или промяна. 

В случай, че сте се идентифицирали пред сървъра чрез цифров сертификат, 
но полето не е попълнено, то най-вероятно ползвате цифров сертификат от 
вид, непозволен за работа със системата. 

3) В полето „Наименование” въведете наименованието на предприятието/ 
счетоводната къща (или име на физическо лице) – допустими са единствено 
букви на кирилица, арабски и римски цифри, кавички и символите / . * -; 

4) В полето „Вид потребител” изберете един от следните: 
 Респондент – потребителите от този вид имат право да въвеждат само 

собствените си отчети. Системата не позволява на потребител от вид 
„Респондент” нито да създава, нито да визуализира отчети на други 
респонденти; 

 Счетоводна къща – потребителите от този вид имат право да създават 
собствените си отчети, както и отчети на други респонденти, с които 
счетоводната къща има такава договореност. Счетоводните къщи имат 
достъп до отчетите, регистрирани в системата от самите тях и до 
собствения си отчет и нямат достъп до другите отчети в системата; 

5) В полето „E-mail за връзка” въведете валиден e-mail адрес за контакт с Вас; 
Внимание: Въведеният от вас e-mail адрес не се проверява автоматично за валидност. 
Въведеният от вас e-mail адрес при необходимост може да бъде използван за връзка с вас. 

6) В полето „Въведете показания код” трябва да въведете цифровия код, който се 
вижда на картинката под полето.  
Внимание: Стойността на картинката се променя след всеки неуспешен опит да създадете 
профила си. След отстраняване на проблема следва да запишете в полето новият код от 
картинката преди да опитате отново действие „Създай”. 

В долната част на страницата са разположени бутоните, с които може да съхраните 
данните в базата данни (БД) или да се откажете от регистрацията. 

Бутонът  изпълнява проверка на въведените данни и съхранява 
информацията в БД, ако въведените данни са коректни. В случай, че има проблеми в 
данните, системата извежда съответни съобщения. За успешната Ви регистрация трябва 
да бъдат изпълнени всички описани по-горе условия и да няма невалидни данни. При 
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успешна регистрация системата визуализира информативно съобщение и автоматично Ви 
насочва към началната страница на системата, откъдето може да продължите с бутона 
„Вход”. 

Бутонът  прекратява операцията по регистриране на нов потребител и 
Ви връща в началната страница на системата. 
Внимание: В тази страница не използвайте стандартните функции на браузъра (Back, 
Forward, Refresh, ръчна промяна на URL адреса и бутона Close в горния десен ъгъл на 
прозореца), а използвайте единствено бутоните “Създай” и „Откажи”. 

2.3 Вход в системата чрез цифров сертификат 

При опит за вход в системата чрез електронен подпис (цифров сертификат) тя ще изиска 
от Вас да укажете цифровия си сертификат, чрез който ще се идентифицирате пред 
системата. Ако сертификатът Ви се съхранява на смарт-карта или USB-карта, ще бъде 
изведено също и запитване за въвеждане на PIN-кода, с който е защитена картата.  
Ако вече сте се регистрирали като потребител на системата и представеният от Вас 
цифров сертификат е от допустимите видове и е валиден, ще се отвори страницата 
„Работа с отчети“. 
Ако представеният от Вас цифров сертификат не е от поддържаните от системата видове 
или ако все още не сте се регистрирали като потребител на системата, системата няма да 
Ви допусне до страницата за работа с отчети. За подробности относно поддържаните 
цифрови сертификати вижте точка 1.3 „Изискване за ползване на цифров сертификат”. 

2.4 Вход в системата чрез ПИК на НАП 

От началото на 2016 г. освен чрез цифров сертификат (т.нар. „електронен подпис“) 
системата позволява вход и чрез ПИК на НАП.  

Важно: Тази възможност може да се ползва само от обикновени респонденти (но не и от 
потребители, регистрирани като „счетоводни къщи“) за работа с отчети по изследване 
НФ1 („Годишни отчети за дейността на нефинансовите предприятия, несъставящи 
баланс“), т.е. потребителските сесии, извършили вход в системата чрез ПИК на НАП, ще 
са ограничени до работа само с отчети по изследване НФ1. За останалите изследвания, 
вкл. и за подаване на декларации за неактивност, е задължително идентифициране чрез 
цифров сертификат. 

 
При опит за вход в ИСБС чрез ПИК на НАП системата ще Ви прехвърли към системата 
на НАП за извършване на идентификация чрез въвеждане на ЕГН/ЛНЧ/ЕИК и персонален 
идентификационен код (ПИК), предоставен Ви от НАП: 
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При успешна идентификация в НАП системата на НАП автоматично ще Ви върне 
обратно в ИС „Бизнес статистика“ (в страницата „Работа с отчети“) с вече осигурен 
достъп за тази потребителска сесия. 
Забележка: За да извършите успешен вход в ИСБС чрез ПИК на НАП е необходимо вече 
да сте се регистрирани в ИСБС като потребител на ИС „Бизнес статистика“, като видът на 
потребителя трябва да бъде „Респондент“. Ако сте регистрирани като „счетоводна къща“, 
системата няма да Ви позволи достъп чрез ПИК на НАП. 
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3. Страница „Профил на потребител” 
Страницата „Профил на потребител” се използва за преглед и редактиране на данните в 
личния Ви профил. 

Страницата се зарежда след натискане на бутона  „Профил”  в дясната горна част на 
заглавната ивица на страницата. Бутонът е достъпен само в защитените страници на ИС 
„Бизнес статистика”, т.е. за разпознат потребител на системата.  

 
Фиг. 13 Изглед на страница „Профил на потребител” 

В секция „Данни за потребителя” системата визуализира информацията за текущия 
потребител и осигурява възможност те да бъдат променени. За промяна са достъпни 
следните полета:  

1) В полето „Вид потребител” можете да промените своя вид, ако той не отговаря 
на действителността. За подробности виж страница „Регистрация на 
потребител”; 

2) В полето „Наименование” може да промените наименованието, с което сте 
регистрирани в системата. Тази информация се използва единствено във Вашия 
профил; 

3) В полето „E-mail за връзка” може да промените предишния посочен от Вас e-
mail адрес за контакт. 

В долната част на секцията „Данни за потребителя” са разположени бутоните, с които 
може да съхраните данните в БД или да се откажете от промените. 

Бутонът  изпълнява проверка на въведените данни и съхранява 
информацията в БД. В случай, че има проблеми в данните, системата извежда съответни 
съобщения. При успешна промяна на данните системата визуализира информативно 
съобщение. 

Бутонът  отменя всички направени от Вас промени в секцията „Данни за 
потребителя”. 

Препратката  Ви връща обратно към страницата, в която сте били преди 
отваряне на страницата „Профил”. 
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4. Страница „Работа с отчети” 
Страницата „Работа с отчети” е основната екранна форма за работа с годишните отчети. 
Страницата предоставя възможност за създаване на нов отчет, търсене на съществуващи 
отчети в БД, въвеждане и редактиране на данни в справки, преглед на констатирани 
проблеми, приключване/сторниране и анулиране/деанулиране на отчет.  
Страницата се зарежда автоматично след успешно разпознаване на потребителя от 
системата, извършено в страница „Вход”. Първоначално страницата се зарежда без да има 
визуализира данни, т.е. допълнително се изисква да извлечете търсения от вас отчет (или 
отчети). 
 
  

 
 

 

Фиг. 14 Изглед на страница "Работа с отчети" 

Работното пространство на страницата условно е разделено на две зони (ляв и десен 
панел) чрез вертикална разделителна линия (splitter). Разделителната линия може да се 

премества с помощта на мишката. С помощта на бутона  в средата на разделителната 
линия може да се скрива/показва левият панел на страницата.  

Секция „Търсене на отчети” 

Секция „Списък на отчети” 

Секция „Детайли на отчета” 

Разделител на страницата с 
бутон за преоразмеряване 
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Страницата се състои от следните секции: 
1) Секция „Търсене на отчети”; 
2) Секция „Списък на отчетите”; 
3) Секция „Детайли на отчета”. 

4.1 Секция „Търсене на отчети” 

В секцията „Търсене на отчети” е предоставена възможност за търсене на съществуващи 
отчети в БД. Тази секция се различава в случаите, когато потребителят, разпознат от 
системата, е вътрешен (служител на НСИ) или външен потребител (респондент или 
счетоводна къща). При вътрешните потребители секцията „Търсене на отчети” 
предоставя възможност за задаване на по-детайлен критерий за търсене. 

4.1.1 Секция „Търсене на отчети” (при външни потребители) 

 
Фиг. 15 Изглед на секция "Търсене на отчети" при външните потребители 

В падащия списък може да изберете критерий, по който искате да търсите – 
възможностите са „ЕИК”, „Име на респондент” или „Отчетен период”. В полето, 
намиращо се от дясната страна на падащия списък, може да въведете стойност, по която 
да се извърши търсене в списъка на всички отчети, до които имате достъп. В случай, че 
полето е оставено празно, при търсене ще бъдат визуализирани всички отчети, до които 
имате достъп. 
Забележка: Ако сте избрали от възможностите „ЕИК” или „Респондент”, в полето за 
търсене може да въведете и само част от търсеното значение. В този случай трябва да 
запишете символа % (маскиране на текста) пред критерия, след него или от двете страни, 
ако търсите за съвпадение съответно по завършваща част, започваща част или съдържаща 
се част.  
Пример:  

1) Търсене на отчети по ЕИК, който започва със 111: 
 Изберете от падащия списък ЕИК 
 Въведете в празното поле стойността 111% 
 Натиснете <Enter> или бутона . 

2) Търсене на отчети, чието наименование на респондента завършва с ООД 
 Изберете от падащия списък Респондент 
 Въведете в празното поле стойността %оод или %ООД (не се прави 

разлика между главни и малки букви) 
 Натиснете <Enter> или бутона . 
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3) Търсене на отчети по ЕИК, който съдържа 111: 
 Изберете от падащия списък ЕИК 
 Въведете в празното поле стойността %111% 
 Натиснете <Enter> или бутона . 

След изпълнение на търсене в таблицата под секцията за задаване на условие се зарежда 
списък на намерените отчети, отговарящи на зададеното условие. Ако няма намерени 
отчети, таблицата остава празна.  
 

4.1.2 Секция „Търсене на отчети” (при служители на НСИ) 

 
Фиг. 16 Изглед на секция „Търсене на отчети” при вътрешните потребители 

 
Фиг. 17 Изглед на секция „Търсене на отчети” при вътрешните потребители 

(разширено търсене) 
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В тази секция има два режима на задаване на условие за търсене – базово и разширено 
търсене. Режимът на търсене може да се смени при натискане на бутона в горния десен 
ъгъл на секцията. В режим на базово търсене има само следните полета за търсене: „ID на 
отчет”, „Състояние”, „С предупреждения”, „ЕИК”, „Респондент” и „Изследване”. 
Можете да зададете условие за търсене в няколко от полетата като опцията 
„Съответствие” указва дали полетата ще се комбинират в критерий чрез логическото 
„И” или чрез логическото „ИЛИ”. Тук полетата „ЕИК”, „Респондент” и „Изследване” 
разрешават търсене по част от значението като при търсене по започваща част няма 
нужда се маскира въведения в полето текст с символа % в неговия край. Но ако искате да 
извършите търсене по завършваща или съдържаща се част, трябвате въведете % преди 
текста. Режимът на разширено търсене разрешава добавянето на още полета за търсене и 
прилагане на специфични оператори за филтриране към тях (Започва с, Равно на, 
Съдържа). 
Пример:  

1) Търсене на отчети с ЕИК, който започва със 111 и име на респондент, което 
започва с ЕТ: 
 Въведете в полето ЕИК стойността 111 
 Въведете в полето Респондент стойността ЕТ (тук се прави разлика 

между главни и малки букви!) 

 Натиснете <Enter> или бутона . 
2) Търсене на отчети с ЕИК, който съдържа 111 и име на респондент, което 

завършва на ООД: 
 Въведете в полето ЕИК стойността %111 
 Въведете в полето Респондент стойността %ООД 

 Натиснете <Enter> или бутона . 
3) Търсене на всички отчети, които са в състояние Нов/Непроверен или състояние 

Проблемен: 

 Натиснете бутона  

 Изберете за съответствие  

 Натиснете бутона  и изберете полето Състояние. По този 
начин се появява второ поле Състояние в секцията. 

 Срещу първото поле Състояние изберете оператор Равно на и стойност  
Нов/Непроверен, а срещу второто изберете оператор  Равно на и стойност 
Проблемен. 

 Натиснете <Enter> или бутона . 
След изпълнение на търсене в таблицата под секцията за задаване на условие се зарежда 
списък на намерените отчети, отговарящи на зададеното условие. Ако няма намерени 
отчети, таблицата остава празна. 
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4.2 Секция „Списък на отчети” 

В тази секция под формата на таблица се визуализират всички отчети, отговарящи на 
търсеното условие, до които имате разрешен достъп. Системата контролира достъпа до 
отчетите по следните правила: 
 Респондентите имат право на достъп само до собствените си отчети. Ако отчетът 

на респондента е въведен от друг потребител на системата (от счетоводна къща 
или от служител на НСИ), достъпът на респондента до отчета е само за четене; 

 Счетоводните къщи имат право на достъп до собствения си отчет и до всички 
отчети, регистрирани от самите тях. Също както при респондентите, ако 
собственият отчет на счетоводната къща е въведен не от нея, а от друг 
потребител на система (например от служител на НСИ), достъпът до отчета е 
само за четене; 

 Служителите от ТСБ имат достъп до отчетите на предприятията с регистрация 
или местонамиране на дейността в обслужвания от това ТСБ регион и до 
отчетите, въведени в това ТСБ; 

 Служителите от НСИ/ЦУ имат достъп до всички отчети в системата.  
 
Таблицата е предназначена само за четене и преглед на отделните редове (отчети). При 
позициониране в конкретен ред от таблицата детайлите на избрания ред (отчет) се 
визуализират в десния панел на страницата. 
В първата колона на таблицата – „Състояние” – е показано текущото състояние на 
съответния отчет. Използвани са различни цветове-индикатори на състоянието както 
следва:  

  Нов / Непроверен; 

  Проблемен; 

  Успешно обработен; 
  Успешно обработен (с предупреждения); 

  Анулиран. 
В останалите колони на таблицата се визуализират съответно ЕИК, името на респондента 
и вида на изследването, за което се отнася отчета. 
  
Таблицата предоставя възможност за сортиране на отчетите по избрана от потребителя 
колона. При позициониране на курсора на мишката върху заглавието на някоя колона се 
визуализират две стрелки – при натискането на някоя от стрелките отчетите се сортират 
във възходящ или низходящ ред в зависимост от избраната стрелка.  
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Чрез бутона  можете да създадете нов отчет. При натискането на бутона се 
отваря диалогов прозорец, където трябва да изберете вид на изследването, за което се 
отнася отчета и да се попълнят данни за заглавната част на отчета – Респондент (ЕИК и 
наименование на предприятието), Ръководител, Съставител, Лице за контакт, Телефон и 
Забележки.  

 
Фиг. 18 Изглед на диалогов прозорец за въвеждане на нов отчет 

 В полето „Респондент” се въвежда наименованието на предприятието – 
допустими са само символи на кирилица, арабски и римски цифри, единична 
кавичка и символите / , -; 

 В полетата „Ръководител”, „Съставител” и „Лице за контакт” се въвеждат 
имената на съответните Ваши отговорни служители – трябва да се въведат от две 
до четири имена, изписани на кирилица. Допустимо е името на съставителя да е 
име на счетоводна фирма; 

 В полето „Тел. за контакт” се въвежда валиден телефон за връзка (Пример: +359 
88 7864334; 088 4538999). 

 
За успешното съхраняване на отчета е необходимо да бъдат попълнени всички 

задължителни полета (маркирани със знака *).  При натискане на бутона  данните за 
новия отчет се съхраняват в базата данни и се визуализират в секцията „Детайли на 
отчета”. При наличие на грешки във въведените данни системата ще изведе съответно 
съобщение с описание на проблемите. След отстраняването им може да ги съхраните 

отново или чрез бутона  да се откажете от създаване на отчета. 

Чрез бутона  можете да промените данните от заглавната част на 
конкретен отчет. При натискането на бутона се отваря същия диалогов прозорец както 
при създаването на нов отчет. Полето „Изследване” може да се променя само в случай, че 
в отчета все още няма въведени справки. Полето „ЕИК” може да се променя само, ако 

потребителят не е от вид „Респондент”. При натискане на бутона  направените 
промени се съхраняват в базата данни. 
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4.3 Секция „Детайли на отчета” 

В тази секция се визуализират заглавните данни за конкретно избран отчет – Респондент 
(ЕИК и наименование на предприятието), Забележки и списъка със справки от отчета. 
При създаване на нов отчет системата автоматично генерира уникален вътрешно системен 
идентификатор на отчета (ID) и според вида на изследването автоматично попълва 
информацията за отчетния период. Ако потребителят, е от вид „Респондент”, системата 
визуализира номера на идентификатора, едва след като отчетът премине в състояние 
„Успешно обработен”. Също така при създаване на нов отчет от респондент, системата 
автоматично попълва и полето за ЕИК и го забранява за промяна, тъй като тези 
потребители имат право да създават само собствените си отчети.  
В горната част на секцията „Детайли на отчета” е разположена лента с бутони, чрез които 
се извършват действията по приключване/сторниране и анулиране/деанулиране на отчета. 
Отделните бутони в тази лента се визуализират в зависимост от текущото състояние на 
отчета. 

4.3.1 Лента с командни бутони 

1) Бутонът  се използва за опресняване върху страницата данните за текущия 
отчет; 

Забележка: Използвайте този бутон, за да опресните информацията за даден 
отчет, в случай че сте съхранили или валидирали конкретна справка, за която се 
използва PDF-форма. PDF-формите се отварят в отделен прозорец на браузъра и 
при тяхното съхраняване или валидиране основният прозорец за работа с отчетите 
не получава информация за извършеното действие. При съхраняване и валидиране 
на справка системата извежда подходящи съобщения за успешно или неуспешно 
действие в самата PDF-форма без да променя визуално статуса на справката в 
страницата на отчета, както и не презарежда автоматично списъка на 
констатираните проблеми при валидирането на справката, ако има такива. 
N.B. Този бутон не е аналогичен на стандартната функционалност на браузъра за 
опресняване на страницата (F5-Refresh). Натискане на клавиша <F5>, както и 
натискане на бутона Refresh на браузъра, трябва да НЕ се извършва. 

2) Бутонът  изпълнява действие „Приключване” (Обработване) на 
целия отчет. При тази обработка системата извършва „Валидиране” на всяка 
попълнена в отчета справка поотделно, след което извършва предвидения 
логически контрол на ниво цял отчет (логическите проверки, касаещи данни 
от повече от една справка едновременно, се изпълняват само при 
приключване на отчета, а не при валидиране на отделните справки). 
Този бутон е достъпен само за отчети в състояние „Нов/Непроверен” и „Проблемен”. 
 
При изпълнение на операцията „Приключване” могат да възникнат следните 
ситуации: 
 При обработката на отчета са констатирани проблеми от тип 

„задължителен контрол” (фатална грешка) – в този случай системата 
маркира отчета като „Проблемен”. Констатираните проблеми се 



Информационна система „Бизнес статистика” 
 
РЪКОВОДСТВО ЗА ПОТРЕБИТЕЛЯ Национален Статистически Институт 

 

 

 50 

преглеждат в тематичната страница „Проблеми” в долната част на секция 
„Детайли на отчета”; 

 При обработката на отчета са констатирани само проблеми от тип 
„препоръчителен контрол” (предупреждения) – в този случай системата  
визуализира съобщение за потвърждение от потребителя, дали отчета да 
бъде приет за успешно обработен. Имате възможност да потвърдите 
обработката или да не я приемете, защото възнамерявате да отстраните 
констатираните предупреждения; 

 При обработката на отчета не са констатирани проблеми – в този случай 
системата маркира отчета като успешно обработен. 

3) Бутонът  изпълнява действие „Сторниране на приключване на 
отчет”, т.е. връщане на отчета от статус „Успешно обработен” обратно в статус 
„Нов / Непроверен”, в който отново може да бъде коригиран и обработван. 
Забележка: Сторниране се налага в случай, че е необходима корекция във вече успешно 
приключен отчет. Ако отчетът е в състояние „Успешно обработен” или „Анулиран”, 
системата забранява редактирането му. Поради това, ако се налага да бъдат променени 
данните в успешно обработен отчет, първо трябва да се сторнира неговото приключване 
(при което отчетът се връща обратно в състояние „Нов/непроверен”), да се нанесат 
промените и да бъде приключен отново. 
Този бутон е достъпен само за отчети в състояние „Успешно обработен”. 

4) Бутонът  изпълнява действие „Анулиране” на „Нов/Непроверен” 
или „Проблемен” отчет. След извършване на действието отчетът променя 
състоянието си в „Анулиран”. При това състояние системата не позволява да се 
променят данните в отчета и те са достъпни само за четене и разпечатване. 
Забележка: Анулиране се извършва в случай на неправилно попълнен отчет – примерно 
неправилно сте попълнили ЕИК при създаване на нов отчет или има много допуснати 
грешки в справките. Системата не позволява промяна на ЕИК в заглавната част на отчет, 
както и изтриване на отчет и при подобен случай трябва да анулирате отчета, ако той не 
трябва да се използва. 
Бутонът е достъпен  само за отчети в състояние „Нов/Непроверен” и „Проблемен”. 

5) Бутонът  изпълнява действие „Деанулиране” на вече анулиран 
отчет. След извършване на операцията отчетът преминава в състояние „Нов / 
Непроверен” и отново може да бъде редактиран и обработван. 
Бутонът е достъпен само за отчети в състояние „Анулиран”. 
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4.3.2 Панел „Детайли на отчета” 
Този панел има различен изглед за вътрешни и външни потребители. В него се 
визуализират „само за четене” заглавните данни за конкретно избран отчет. 

 
Фиг. 19 Изглед на панела „Детайли на отчет” за вътрешни потребители (служители на НСИ) 

 

 
Фиг. 20 Изглед на панела „Детайли на отчет” за външни потребители 

За промяна на заглавните данни в отчета („Изследване”, „ЕИК”, „Респондент” или 

„Забележки”) трябва да натиснете бутона  в секцията „Списък на 
отчети”. Полето „Изследване” може да се променя само в случай, че все още няма 
въведени справки в отчета. Полето „ЕИК” може да се променя само от служители на НСИ 
или счетоводни къщи, тъй като потребителите от вид „Респондент” могат да въвеждат и 
редактират само собствените си отчети.  
При външните потребители номерът на уникално генерирания системен идентификатор 
(Входящ номер) се визуализира, след като отчетът премине в състояние „Успешно 
обработен”.  
Долната част от секцията „Детайли на отчета” е разделена на три тематични страници, 
както следва: 
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4.3.3 Тематична страница Справки 

 
Фиг. 21 Изглед на тематична страница "Справки" 

В тематичната страница „Справки” системата визуализира списък на всички справки от 
годишния отчет, които са дефинирани за съответният вид изследване. Списъкът е 
различен според вида на изследването. 

1) В първата колона на таблицата се визуализира пореден номер на справката; 
2) В следващата колона се визуализира пълното наименование на справката, което 

представлява препратка за отваряне на справката. Всички справки с изключение 
на „Справка за предприятието”, „Справка за група предприятия“, „Справка 
ПРОДЕНЕРДЖИ“ и „Справка ПРОДКОМ” се отварят като PDF-форми; 

3) В колоната „Състояние” се визуализира текущото състояние на съответната 
справка: 
Справката може да бъде в едно от следните три състояния –  „Непроверена”, „Валидна”, 
„Проблемна”, а също може и полето да е празно. Когато полето е празно, това е 
индикатор, че справката не е въвеждана до този момент (т.е. в базата данни липсва 
съхранена такава справка). В състояние „Непроверена” са тези справки, в които са 
съхранени данни, които все още не са валидирани. В състояние „Валидна” са справките, 
които са съхранени и са валидирани успешно, а в състояние „Проблемна” са справките, 
при чиято валидация са открити проблеми от тип „фатална грешка”. 

4) В колоната „Код на бланката” се визуализира използваният от системата код за 
идентификация на всяка бланка; 
Забележка: Кодът на справката се използва в текста на констатираните проблеми при 
приключване на отчет; 

5) В последната колона на таблицата има бутон , чрез който системата 
позволява в случай на нужда да бъде изтрита съответната справка от отчета. 
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В отчета се попълват само тези справки, за които имате задължение да се отчитате. В 
логическите проверки са заложени контроли, които изискват да имате попълнена дадена 
справка. Не е необходимо да отваряте и да съхранявате празни справки, които не трябва 
да отчитате. В случай, че сте съхранили празна справка, системата ще регистрира 
проблем, с който не може да приключите отчета. За да отстраните проблема, или 
попълнете справката, или я изтрийте с помощта на бутона в списъка със справките. 
Бутонът е достъпен докато отчетът е разрешен за редактиране. 

 
Системата предоставя функционалност за въвеждане на детайлни справки за някои от 
отчетите. За подробности относно създаването им виж точка „4.3.6 Създаване на детайлна 
справка” от настоящия документ. 
 
При отваряне на справка от списъка (чрез mouse click върху наименованието на 
справката), за която се използва PDF-форма, отваряната справка се зарежда в отделен 
прозорец на браузъра, където автоматично се активира Adobe Reader plug-in. Системата 
автоматично попълва данните в полетата „Отчетна единица”, „Гр. (с.)”, „Община”, „ЕИК 
по БУЛСТАТ / ТР”, които са полета само за четене. При въвеждането на детайлни 
справки аналогично се попълват и полетата „Обл.”, „Общ.”, „Дейност” и „Звено”. 
Полетата в края на бланката : „Ръководител”, „Съставител”, „Лице за контакт”, „Дата” и 
„Телефон”, също се попълват автоматично от системата, но данните в тях (с изключение 
на „Ръководител”) могат да се променят, ако са различни за конкретната справка. При 
първо отваряне на справка данните се извличат от заглавните детайли на отчета и се 
попълват в тези полета.  
В PDF-формите се попълват данните в полетата, разрешени за попълване. Част от 
полетата са дефинирани като сумарни полета или се получават в резултат на изчисления. 
Тези полета не са достъпни за промяна от потребителя. Техните стойности автоматично 
се изчисляват при попълване на полетата, участващи в изчислението им.  

Бутонът  в края на PDF-формата се използва, за да се съхранят 
направените промени в справката в базата данни.  

Бутонът  в края на PDF-формата изпълнява последователно действие 
„Съхраняване” и действие „Валидиране” на справката, при което системата извършва 
предвидения логически контрол на данните в справката. След като се валидира една 
справка системата извежда информативно съобщение, описващо констатираните 
проблеми и техния вид, ако има такива. Ако не са констатирани проблеми, системата 
извежда информативно съобщение за успешно „Валидиране”. След съхраняване или 
валидиране на PDF-форма, за да видите в основния прозорец на приложението актуалния 

(новия) статус на справката, трябва да използвате бутона  в горната част на основния 
прозорец, чрез който се извършва опресняване на данните за текущия отчет в страницата 
на браузъра. 
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Важно: Системата се изключва автоматично, ако повече от 30 минути от Вашия браузър 
няма изпратена никаква заявка към сървъра. В частност, ако отворите PDF-справка и 
работите в нея повече от 30 минути без да съхраните (или валидирате) данните, въведени 
на екрана, системата ще се изключи. В този случай ще загубите данните, въведени на 
екрана и ще трябва да ги въведете отново. За да избегнете подобна ситуация, ако сте 
въвели или коригирали някакви данни, ги съхранете своевременно без да чакате 
прекалено дълго време. По-късно винаги можете да коригирате съхранените данни, ако се 
наложи.  
 
Важно: Справките могат да бъдат разглеждани on-line или разпечатвани дори и след края 
на срока за подаване на съответните отчети.  
 
Важно: Копия на попълнените справки от отчета могат да бъдат съхранявани като 
файлове локално на Вашия компютър. Тази функционалност е налична за отчетите от 
2012 година нататък. Локално съхранените копия на справките не могат да бъдат 
редактирани и/или подавани по-късно към системата (т.е. това не е функционалност за 
работа в режим off-line, а е само възможност за поддържане на архив на подадените 
отчети локално на Вашия компютър). За повече подробности виж глава 11.3. 
„Съхраняване на съдържанието на отчети локално на компютъра”. 
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4.3.4 Тематична страница „Проблеми” 
В тематичната страница „Проблеми” системата визуализира в йерархичен вид всички 
констатирани проблеми от задължителен характер (фатални грешки) и/или от 
препоръчителен характер (предупреждения) в рамките на целия отчет. 

 
Фиг. 22 Изглед на тематична страница "Проблеми" 

Констатираните проблеми са групирани и подредени по справки, а тези, които не касаят 
конкретна справка или касаят кръстосана проверка между различни справки, са 
обособени в отделна група („Проблеми на ниво Отчет”). Системата позволява да 
отваряте или затваряте групите в йерархията чрез бутона View или чрез контекстно меню. 

Системата позволява списъкът с проблемите да се експортира в MS Excel чрез бутона . 
При изпълнението на това действие се експортират само тези проблеми, които се 
визуализират на екрана. (В частност, ако сте обработили някоя справка в PDF-формат, 
първо опреснете данните за отчета чрез бутона  в горната част на екрана, след което 
експортирайте проблемите в MS Excel). 
 
Забележка: Проблемите, свързани с кръстосани засичания на свързани данни от различни 
справки, се визуализират в групата „Проблеми на ниво Отчет” (виж фигурата по-горе). 
Кръстосаните проверки между данните на различни справки не се извършват при 
валидиране на отделна справка, а се извършват само при опит за приключване на целия 
отчет. Поради тази причина при валидиране на отделна справка списъкът на проблемите 
от групата „Проблеми на ниво отчет” не се изчиства автоматично. За да го актуализирате 
или изчистите (след като сте коригирали проблемните справки), трябва отново да 

направите опит за приключване на отчета чрез натискане на бутона . 
Не се притеснявайте, че може погрешно да приключите отчета преди да сте завършили 
напълно неговото въвеждане, тъй като винаги може да сторнирате приключването чрез 

бутона . 
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4.3.5 Тематична страница „Служебна информация” 
В тематичната страница „Служебна информация” системата визуализира за четене 
следните служебни данни за отчета:  
 Имена и телефон на служителите, отговорни за попълнените данни в отчета;  
 От кой потребител е регистриран първоначално отчета; 
 Точно време на регистриране на отчета; 
 От кой потребител последно е направена промяна в данните на отчета; 
 Точно време на последна промяна; 
 Кой потребител е обработил последно отчета; 
 Точно време на последната обработка на отчета. 
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4.3.6 Създаване на детайлна справка за поделение или различна 
икономическа дейност 
За някои справки в дадени изследвания (например за справка ТРУД) системата 
предоставя възможност за регистриране на детайлни справки, съдържащи данни само за  
определена област, община и икономическа дейност. В тематичната страница „Справки”, 
въведените детайлни справки се визуализират в списъка под съответната обобщена 
справка от годишния отчет. 

 
Фиг. 23 Изглед на списъка с въведени детайлни справки за ТРУД 

Въвеждането на нова детайлна справка се извършва като под наименованието на 
съответната обобщена справка се натисне препратката: 
  
При това се отваря диалогов прозорец, където трябва да се укажат „Област”, „Община”, 
„Икономическа дейност” и „Номер на поделение”.  
 

 
Фиг. 24 Изглед на диалогов прозорец за въвеждане на нова детайлна справка 

Полетата в диалоговия прозорец, които са маркирани със знака *, са задължителни за 

въвеждане. При натискане на бутона  се отваря съответната PDF-форма, където 
потребителят попълва данни  за съответното поделение или икономическа дейност. Едва 

при натисне на бутона  в края на PDF-формата въведената детайлна 
справка се съхранява в базата данни на системата. За да видите справката в списъка с 

отчети трябва да натиснете бутона  за опресняване на данните. 
 
Забележка: При въвеждане на детайлна справка на нефинансово предприятие системата 
не изисква указване на икономическа дейност, тъй като в този случай по подразбиране се 
използва основната икономическа дейност, изчислена в „Справка за предприятието”. 
Забележка: При попълване на справка ТРУД институциите (вкл.общините), които 
подават отчети по изследване „<Година>-БПБ” и които имат повече от една дейност или 
извършват дейност в повече от една община, могат да подадат само детайлни справки 
(т.е. не е задължително да подадат обобщена справка за цялата институция). 
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5. Страница „Справка на предприятието” 
Страницата „Справка на предприятието” предоставя възможност за въвеждане и 
редактиране на данните от справката за предприятието в годишния отчет.  
Страницата се зарежда за конкретно избран отчет от страница „Работа с отчети”, чрез 
избор на препратката Справка за предприятието през 2013 година от списъка със 
справките в отчета. 
Страницата „Справка на предприятието” се състои от няколко раздела, както следва: 

5.1 Лента с командни бутони 

В горната част на страницата „Справка за предприятието” е разположена лента с бутони, 
извършващи необходимите операции по съхраняване на данните, отмяна на направените 
промени и валидиране на справката. 

1) Бутонът   се използва за връщане към страница „Работа с 
отчети”: 
При натискане на този бутон системата проверява за извършени промени и ако има 
направени промени, възпрепятства връщането назад до съхраняване или отмяна на тези 
промени. Системата извежда съответно предупредително съобщение за извършени 
промени, които не са потвърдени или отменени. В този случай преди да напуснете 
страницата, трябва да вземете решение дали да съхраните или отмените промените, след 
което отново можете да натиснете бутона . 

2) Бутонът  отваря отваря нов прозорец с PDF-бланка, попълнена с 
данните от „Справка за предприятието“: 
PDF-бланката се използва само за разпечатване в необходимия формат или съхраняване на 
копие от справката на локалния компютър (като съхраняване може да се извършва само за 
изследванията от ГОД-2012 включително нататък). 

3) Бутонът  съхранява направените от Вас промени, ако има такива; 

4) Бутонът  отменя направените от Вас промени, ако има такива: 
Отмяна може да бъде правена само на промените, които са нанесени на екрана и все още 
не са съхранени в БД. Ако сте направили промени и вече сте ги съхранили в БД чрез 

бутона , тези промени няма да бъдат отменени. В подобна ситуация трябва да 
въведете в полетата на екрана старите стойности и да ги съхраните в БД. 

5) Бутонът  изпълнява действие „Валидиране” на справката на 
предприятието, при което системата извършва предвидения логически контрол 
за справката; 
При наличие на проблеми системата ще изведе съобщение с кратко описание на 
констатираните при валидирането проблеми. Възможно е да бъдат констатирани 
проблеми от задължителен характер (фатални грешки) и/или от препоръчителен характер 
(предупреждения). При наличие на фатални грешки системата маркира справката като 
„Проблемна”. При липса на проблеми или наличие само на предупреждения системата 
маркира справката като „Валидна”. 
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5.2  Раздел „Име и адрес на предприятието” 

 
Фиг. 25 Изглед на раздел „Име и адрес на предприятието” 

В този раздел се попълват данни за адреса на предприятието и допълнителна информация 
като телефони, Интернет страница и електронна поща. Въвеждането на информацията се 
извършва последователно отляво на дясно и отгоре надолу. За успешното въвеждане на 
този раздел е необходимо да бъдат въведени всички задължителни полета и поне един 
телефонен номер или мобилен телефон.  
Попълването на полетата „Населено място” и „Улица” се извършва чрез помощен списък, 
който се визуализира след натискане на бутона . Тези помощни списъци се филтрират 
в зависимост от избраната административна област, община и населено място. 
Забележка: Полето „Код по ЕКАТТЕ” се попълва автоматично от системата след 
избиране на населено място от помощния списък. 
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5.3 Раздел „Място на извършване на дейността” 

 
Фиг. 26 Изглед на раздел „Място на извършване на дейността” 

В този раздел се попълва населеното място, в което предприятието извършва 
преобладаващата си дейност (това е дейността, изчислена като „Основна дейност по 
КИД-2008” при валидирането на справката – виж в раздел „Други данни”), както и на 
колко места предприятието извършва дейност. Ако броят места, на които предприятието 
извършва дейност, е по-голям от 1, трябва да бъдат въведени толкова на брой записа в 
раздела „Местни единици”. 
Попълването на полето „Населено място” се извършва аналогично на подобното поле в 
раздел „Име и адрес на предприятието”. 
Забележка: Полето „Код по ЕКАТТЕ”, „Код на поречие” и „Поречие” се попълват 
автоматично от системата след избиране на населено място от помощния списък. 

5.4 Раздел  „Собственост” 

 
Фиг. 27 Изглед на раздел „Собственост” 

В този раздел се въвеждат в % относителните дялове от капитала за отделните видове  
собственост, които предприятието има. Допустими са числа с десетична запетая до 2 
знака в интервала 0,01 до 100,0. Сборът на всички дялове трябва задължително да е равен 
на 100%. Не е необходимо да се попълват нули за видовете собственост, които 
предприятие няма.  
Забележка: Разделът не се визуализира и не се попълва в Отчета на еднолични търговци 
по чл.32 от Закона на счетоводството. 
Забележка: При въвеждането на дробни числа трябва да се използва символът запетая (,), 
а не точка (.). 
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5.5 Раздел „Икономическа дейност” 

 
Фиг. 28 Изглед на раздел „Икономическа дейност” 

В този раздел се въвеждат икономическите дейности на предприятието, за които то има 
ненулев дял на приходите от продажби. За извършване на действия в таблицата се 
използва лентата с бутони в горната й част: 
Създаването на нов запис в таблицата с икономически дейности се извършва чрез бутона 

. Новият запис след натискане на бутона се създава най-отпред в таблицата.  
Изтриването на вече въведен запис в таблицата с икономически дейности извършвани от 
предприятието се осъществява чрез бутона . При натискането на бутона 

 системата изисква допълнително потвърждение. 
Данните, които се въвеждат в този раздел, са както следва: 
 При създаване на нов запис системата автоматично генерира пореден номер в 

полето „№”, който при желание от страна на потребителя може да бъде 
променен преди съхраняването на записа в БД. След съхраняване на записа 
полето се забранява за промяна. 
Забележка: Стойността в полето трябва да бъде цяло число, уникално в рамките на 
таблицата с дейностите за конкретното предприятие. 

 Полето „Дейности, които е извършвало предприятието” се попълва автоматично 
от системата след  попълване на полето „Код по КИД-2008 (виж по-долу).  

 В полето „Относителен дял на тази дейност” ръчно се въвежда процентният дял 
на дейността (цяло число в %); 
Сборът на относителните дялове на всички въведени икономически дейности трябва да е 
не по-малък от 75% и не трябва да надвишава 100%. Проверката на този сбор се извършва 
от системата при валидиране на справката. 

 В полето „Код по КИД-2008” се въвежда код от класификатора на 
икономическите дейности КИД-2008. Кодът може да се въведе ръчно в 
необходимия формат (например 46.38) или чрез използване на помощен списък, 
визуализиран след натискане на бутона  (виж забележките по-долу). След 
попълване на полето системата търси съответстващия код от класификацията на 
икономическите дейности по НКИД-2003. Възможни са следните случаи: 
 На избраната икономическа дейност по КИД-2008 съответства точно една 

дейност по НКИД-2003 – в този случай системата автоматично попълва 
полето „Код по НКИД-2003”; 
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 На избраната икономическа дейност по КИД-2008 съответства повече от 
една дейност по НКИД-2003 – в този случай собственоръчно трябва да 
изберете елемент от помощния списък на класификатора по НКИД-2003; 

 Полето „Код по НКИД-2003” се попълва автоматично от системата или чрез 
използване на помощния списък. 

 
Забележка: В помощния списък за избор на икономическа дейност можете да търсите по 
част от името на дейността. Така, например, ако искате да извлечете списъка на всички 
дейности, в името на които се съдържа низът „зелен”, трябва да напишете в полето за 
търсене „%зелен” (без кавичките) и да натиснете кръглия бутон вдясно от полето: 

 
Фиг. 29 Търсене в помощен списък по част от наименование 

Ако в полето за търсене не напишете символа % в началото на низа, помощният списък 
ще извлече само тези дейности, чиито имена започват със „зелен”. 
 
Забележка: Помощните списъци на класификациите на икономическите дейности 
взаимно се филтрират. При попълнен код по КИД-2008 списъкът от дейностите по 
НКИД-2003 се ограничава до съответстващите елементи на попълнения код по КИД-2008. 
При попълнен код по НКИД-2003 списъкът от дейностите по КИД-2008 се ограничава до 
съответстващите елементи на попълнения код по НКИД-2003. Ако искате да попълните 
друг код, който не се визуализира в списъка, трябва да изтриете ръчно стойността на 
полето „Код по КИД-2008”, след което списъкът ще покаже пълната класификация. 
Забележка: Кодът по КИД-2008 не трябва да се дублира в таблицата с икономическите 
дейности на конкретното предприятие, т.е. не може в таблицата да има 2 или повече реда 
с един и същ код на дейност по КИД-2008.  
Забележка: Максималният брой записи в таблицата с икономически дейности за 
еднолични търговци по чл.32 от Закона на счетоводството е 6, а за предприятия 
задължени да предоставят счетоводен баланс, е 10. Ако предприятието има повече 
дейности, трябва да бъдат въведени първите 6 (респективно 10), които са с най-голям дял. 
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5.6 Раздел „Социално предприятие“ 

 
Фиг. 30 Изглед на раздел "Социално предприятие" 

Този раздел фигурира само в някои изследвания. В него трябва да укажете дали Вашето 
предприятие реализира дейности със социална насоченост (виж инструкциите в долната 
част на раздела в потребителското приложение).  

5.7 Раздел „Клонове (поделения, филиали) извън България“ 

 
Фиг. 31 Изглед на раздел "Клонове (поделения, филиали) извън България " 

Този раздел фигурира в „Справка за предприятието“ само в някои изследвания. На 
въпроса в началото на раздела трябва да отговорите с „Да“, само ако предприятието не е 
част от група предприятия (т.е. ако във въпрос 1 в „Справка за група предприятия“ е 
отговорено с „0 – Не е част от ГП“), но предприятието притежава клонове (поделения, 
филиали) в чужбина. 
Ако отговорите с „Да“ на въпроса в началото на раздела, системата ще визуализира 
таблицата под въпроса, в която трябва да въведете списъка на клоновете/поделенията/ 
филиалите в чужбина. Добавянето на клон/поделение/филиал се извършва чрез бутона 

 от лентата с бутони над таблицата. Чрез бутона  можете да изтриете 
вече въведен клон/поделение/филиал. 
Важно: При разпечатване на „Справка за предприятието“ системата не разпечатва 
автоматично списъка на въведените клонове/поделения/филиали.  За да разпечатате 
списъка на въведените клонове/поделения/филиали, използвайте бутона  от 
лентата с бутони над таблицата. 



Информационна система „Бизнес статистика” 
 
РЪКОВОДСТВО ЗА ПОТРЕБИТЕЛЯ Национален Статистически Институт 

 

 

 64 

5.8 Раздел „Местни единици” 

 
Фиг. 32 Изглед на раздел "Местни единици" 

В този раздел се въвеждат данни за всички активни местни единици на предприятието. 
Разделът се визуализира единствено за предприятия, извършващи дейност на повече от 1 
място, т.е. ако стойността в полето „На колко места Вашето предприятие извършва 
дейност” в раздел „Място на извършване на дейността” е по-голяма от 1 (полето се 
визуализира и попълва само в определени изследвания). 

Въвеждането на данни за местна единица се извършва чрез бутона  от лентата с 
бутони над таблицата на местните единици. След натискането на бутона се отваря нов 
прозорец със заредена страница „Справка за местните единици”, в която се въвеждат 
необходимите данни (за подробности виж страница „Справка за местните единици”). В 
таблицата на местните единици се визуализират избрани полета от данните на 
въведените местни единици. 
При необходимост от корекции на въведените данни за определена местна единица 
използвайте бутона , който визуализира в отделен прозорец данните на 
избраната (селектираната) в таблицата местна единица. 
Бутонът  се използва за изтриване на вече въведена местна единица.  

Бутонът  отваря нов прозорец с PDF-бланка, попълнена с данните на 
избраната в таблицата местна единица. PDF-бланката се използва само за  разпечатване в 
необходимия формат или съхраняване на копие от справката на локалния компютър 
(като съхраняване може да се извършва само за изследванията от ГОД-2012 вкл. нататък). 

5.9 Раздел „Други данни” 

 
Фиг. 33 Изглед на раздел „Други данни” 

Данните в този раздел се изчисляват и визуализират автоматично от системата след 
валидиране на „Справка на предприятието”, което се извършва чрез бутона . 
Данните в раздела се изчисляват по определени алгоритми, заложени в системата. 
Данните в този раздел са само за четене и не могат да бъдат променяни ръчно. 
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6. Страница „Справка за местна единица” 
Страницата „Справка за местна единица” предоставя възможност за въвеждане и 
редактиране на данните за конкретна местна единица. 

Страницата се зарежда чрез натискане на бутона  или  в раздел 
„Местни единици” на страницата „Справка на предприятието” на конкретно избран отчет. 

 
Фиг. 34 Примерен изглед на „Справка за местна единица“ 
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6.1 Лента с командни бутони 

В горната част на страницата „Справка за местни единици” е разположена лента с бутони, 
извършващи необходимите операции по съхраняване на данните и отмяна на направените 
промени: 

1) Бутонът  съхранява направените от Вас промени, ако има такива, 
след което визуализира отново страницата „Справка на предприятието”; 

При натискането на бутона  системата проверява дали са попълнени 
задължителните полета в страницата и дали е спазен необходимия формат за въвеждане. В 
случай, че това не е изпълнено, системата визуализира съответно съобщение за грешка, 
направените промени не се съхраняват в базата данни и се възпрепятства връщането в 
страницата „Справка на предприятието”. 

2) Бутонът  отменя направените от Вас промени, ако има такива 
след което визуализира отново страницата „Справка на предприятието”; 

3) Бутонът  визуализира методологическите указания за попълване на 
страницата. 

4) Бутонът  отваря нов прозорец с PDF-бланка, попълнена с данните на 
избраната (селектираната) в таблицата местна единица. PDF-бланката се 
използва единствено за разпечатване в необходимия формат или съхраняване на 
копие от справката на локалния компютър (като съхраняване може да се 
извършва само за изследванията от ГОД-2012 включително нататък). 
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6.2 Раздел „Идентификация на местната единица“ 

В най-горната част на справката трябва да се укаже дали местната единица е нова или е 
съществувала и през предходната година. 
Ако бъде указано, че местната единица е съществуваща, в екрана ще се появи падащ 
списък с наличните местни единици на това предприятие в Регистъра на статистическите 
единици на НСИ. В този списък трябва да се укаже коя съществуваща местна единица от 
регистъра е тази. В полето под падащия списък ще се визуализира адресът на избраната 
местна единица от РСЕ (такъв, какъвто е регистриран в РСЕ). Името и адреса на местната 
единица също така ще се попълнят автоматично по-долу, където можете да ги 
редактирате, ако старите данни вече не са актуални. 
 

 
Фиг. 35 Избор на съществуваща местна единица 

Ако пък бъде указано, че местната единица е нова (т.е. не е съществувала през 
предходния период и за нея тепърва се подават данни), името и мястото на извършване на 
дейността трябва да се попълнят ръчно. 

6.3 Раздел „Място на извършване на дейността” 

В този раздел се попълват данни за мястото на извършване на дейността, както и 
допълнителна информация като телефони, Интернет страница и електронна поща. 
Въвеждането на информацията се извършва последователно отляво на дясно и отгоре 
надолу. За успешното въвеждане на този раздел е необходимо да бъдат въведени всички 
задължителни полета и поне един телефонен номер или мобилен телефон.  
Попълването на полетата „Населено място” и „Улица” се извършва чрез помощен списък, 
който се визуализира след натискане на бутона . Тези помощни списъци се филтрират 
в зависимост от избраната административна област, община и населено място. 
Забележка: Полетата „Код по ЕКАТТЕ”, „Код на поречие” и „Поречие” се попълват 
автоматично от системата след избиране на населено място от помощния списък. 
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6.4 Раздел „Икономическа дейност“ 

 
Фиг. 36 Изглед на раздел „Икономическа дейност ” 

В този раздел се указва икономическа дейност на местната единица: 
 В полето „Код (КИД-2008)” се въвежда код от класификатора на 

икономическите дейности КИД-2008. Кодът се въвежда ръчно в необходимия 
формат (например 46.38) или чрез използване на помощен списък, визуализиран 
след натискане на бутона . След попълване на полето система търси 
съответстващия код от класификатора на икономическите дейности по НКИД-
2003. Възможни са следните случаи: 
 На избраната икономическа дейност по КИД-2008 съответства точно една 

дейност по НКИД-2003 – в този случай системата автоматично попълва 
полето „Код по НКИД-2003”; 

 На избраната икономическа дейност по КИД-2008 съответства повече от 
една дейност по НКИД-2003 – в този случай потребителят 
собственоръчно трябва да избере елемент от помощния списък на 
класификатора по НКИД-2003. 

 Полето „Код по НКИД-2003” се попълва автоматично от системата или чрез 
използване на помощния списък; 

 Полето „Вид дейност – описание” се попълва автоматично от системата след  
попълване на полето „Код по КИД-2008. 

6.5 Раздел „Други данни ” 

 
Фиг. 37 Изглед на раздел „Други данни” 

В този раздел се въвежда допълнителна информация за местната единица като брой 
заети/наети лица, приходи от продажби, разходи за възнаграждение и др. 
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7. Декларация за предприятие без стопанска 
дейност. 
Страницата „Декларация за предприятие без стопанска дейност” предоставя възможност 
за въвеждане и редактиране на данните от декларацията за предприятие без стопанска 
дейност. 
Страницата се зарежда за конкретно избран отчет (от тип „xxxx-БСД”) от страница 
„Работа с отчети”, чрез избор на препратката Декларация за предприятие без стопанска 
дейност от списъка със справките в отчета. 
Страницата „Декларация за предприятие без стопанска дейност” съдържа лента с 
командни бутони и страница, които обхваща информацията, съдържаща се в 
декларацията, както следва: 

7.1 Лента с командни бутони 

В горната част на страницата „Справка за предприятие без стопанска дейност” е 
разположена лента с бутони, извършващи необходимите операции по съхраняване на 
данните, отмяна на направените промени и валидиране на справката. 

1) Бутонът  се използва за връщане към страница „Работа с 
отчети”; 
При натискане на този бутон системата проверява за извършени промени и ако има 
направени промени, възпрепятства връщането назад до съхраняване или отмяна на тези 
промени. Системата извежда съответно предупредително съобщение за извършени 
промени, които не са потвърдени или отменени. В този случай преди да напуснете 
страницата, трябва да вземете решение дали да съхраните или отмените промените, след 
което отново можете да натиснете бутона . 

2) Бутонът  отваря отваря нов прозорец с PDF-бланка, попълнена с 
данните от справката: 
PDF-бланката се използва само за за разпечатване в необходимия формат или съхраняване 
на копие от справката на локалния компютър (като съхраняване може да се извършва само 
за изследванията от ГОД-2012 включително нататък). 

3) Бутонът  съхранява направените от Вас промени, ако има такива; 

4) Бутонът  отменя направените от Вас промени, ако има такива; 
Отмяна може да бъде правена само на промените, които са нанесени на екрана и все още 
не са съхранени в БД. Ако сте направили промени и вече сте ги съхранили в БД чрез 

бутона , тези промени няма да бъдат отменени. В подобна ситуация трябва да 
въведете в полетата на екрана старите стойности и да ги съхраните в БД. 

5) Бутонът  изпълнява действие „Валидиране” на декларация за 
предприятие без стопанска дейност, при което системата извършва предвидения 
логически контрол за справката; 
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При наличие на проблеми системата ще изведе съобщение с кратко описание на 
констатираните при валидирането проблеми. Възможно е да бъдат констатирани 
проблеми от задължителен характер (фатални грешки) и/или от препоръчителен характер 
(предупреждения). При наличие на фатални грешки системата маркира справката като 
„Проблемна”. При липса на проблеми или наличие само на предупреждения системата 
маркира справката като „Валидна”. 

7.2 Обща информация за декларация за предприятие без 
стопанска дейност. 

 
Фиг. 38 Изглед на тематична страница „Декларация за предприятие без стопанска дейност” 

 
В тази страница се въвежда и редактира информацията, която се съдържа в декларацията 
за предприятие без стопанска дейност, като се спазват общите принципи за въвеждане и 
редактиране на данни в системата. 
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8. Страница „Справка за група предприятия” 
Страницата „Справка за група предприятия” предоставя възможност за въвеждане и 
редактиране на данните от справка за група предприятия в годишния отчет. 
Страницата се зарежда за конкретно избран отчет от страница „Работа с отчети”, чрез 
избор на препратката Справка за група предприятия от списъка със справките в отчета. 
Страницата „Справка за група предприятия” съдържа лента с командни бутони и две 
тематични страници, които обхващат обща информация и данни за отделните членове на 
групата от предприятия, както следва: 

8.1 Лента с командни бутони 

В горната част на страницата „Справка за група предприятия” е разположена лента с 
бутони, извършващи необходимите операции по съхраняване на данните, отмяна на 
направените промени и валидиране на справката. 

1) Бутонът  се използва за връщане към страница „Работа с 
отчети”; 
При натискане на този бутон системата проверява за извършени промени и ако има 
направени промени, възпрепятства връщането назад до съхраняване или отмяна на тези 
промени. Системата извежда съответно предупредително съобщение за извършени 
промени, които не са потвърдени или отменени. В този случай преди да напуснете 
страницата, трябва да вземете решение дали да съхраните или отмените промените, след 
което отново можете да натиснете бутона . 

2) Бутонът  съхранява направените от Вас промени, ако има такива; 

3) Бутонът  отменя направените от Вас промени, ако има такива; 
Отмяна може да бъде правена само на промените, които са нанесени на екрана и все още 
не са съхранени в БД. Ако сте направили промени и вече сте ги съхранили в БД чрез 

бутона , тези промени няма да бъдат отменени. В подобна ситуация трябва да 
въведете в полетата на екрана старите стойности и да ги съхраните в БД. 

4) Бутонът  изпълнява действие „Валидиране” на справка за група 
предприятия, при което системата извършва предвидения логически контрол за 
справката; 
При наличие на проблеми системата ще изведе съобщение с кратко описание на 
констатираните при валидирането проблеми. Възможно е да бъдат констатирани 
проблеми от задължителен характер (фатални грешки) и/или от препоръчителен характер 
(предупреждения). При наличие на фатални грешки системата маркира справката като 
„Проблемна”. При липса на проблеми или наличие само на предупреждения системата 
маркира справката като „Валидна”. 

5) Бутонът  визуализира методологическите указания за попълване на 
справката. 

6) Бутонът  отваря нов прозорец с PDF-бланка, в която са попълнени и 
форматирани за печат данните от попълнената справка за група предприятия. 
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PDF-бланката се използва само за разпечатване в необходимия формат или 
съхраняване на копие от справката на локалния компютър (като съхраняване 
може да се извършва само за изследванията от ГОД-2012 включително нататък). 

8.2 Обща информация за групата от предприятия 

 
Фиг. 39 Изглед на тематична страница „Обща информация за ГП” (неконсолидиран отчет) 
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В тази тематична страница се попълва обща информация за групата предприятия (ГП). 
Въвеждането на данните се извършва последователно отгоре надолу. В зависимост от 
избрания отговор на първи въпрос се визуализират полетата, които е желателно да бъдат 
попълнени и се скриват тези, за които не трябва да се въвежда информация. Също така 
втората тематична страница „Членове на ГП” се визуализира и попълва само, ако на 
първи въпрос отговорът е ‘1’ или ‘2’ (т.е. Глава на ГП). При опит за напускане на 

страницата или при натискане на някой от бутоните  или   се 
проверява, дали са попълнени данни в задължителните полета, които се определят според 
отговора на първи въпрос. 

8.3 Членове на групата от предприятия 

 
Фиг. 40 Изглед на тематична страница „Членове на ГП” 

В тази тематична страница се попълват данни за всяка една правна единица или 
юридическо лице, които са част от групата предприятия. Страницата е достъпна само, ако 
на първи въпрос от „Обща информация за ГП” е отбелязано, че предприятието е глава на 
група предприятия.  

Създаването на нов запис в таблицата се извършва чрез бутона . След натискане на 
бутона новият запис се създава най-отгоре в таблицата. За успешното въвеждане на ред е 
необходимо да бъдат попълнени всички задължителни полета.  Изтриването на вече 
въведен запис в таблицата с данни се осъществява чрез бутона .  
Общият брой въведени редове трябва да съответства на броя, указан във въпрос ‘3.3’ от 
страницата с обща информация за групата. 
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9. Страница „Справка ПРОДКОМ” 
Страницата „Справка ПРОДКОМ” предоставя възможност за въвеждане и редактиране на 
данните от справка за производството и продажбите на промишлени продукти. 
Страницата се зарежда за конкретно избран отчет от страница „Работа с отчети”, чрез 
избор на препратката Справка за производството и продажбите на промишлени продукти 
от списъка със справките в отчета. 
Страницата „Справка ПРОДКОМ” съдържа лента с командни бутони и две тематични 
страници, които обхващат информацията от раздели I, II и III, описани по-долу както 
следва: 

9.1 Лента с командни бутони 

В горната част на страницата „Справка ПРОДКОМ” е разположена лента с бутони, 
извършващи необходимите операции по съхраняване на данните, отмяна на направените 
промени и валидиране на справката. 

1) Бутонът  се използва за връщане към страница „Работа с 
отчети”; 
При натискане на този бутон системата проверява за извършени промени и ако има 
направени промени, възпрепятства връщането назад до съхраняване или отмяна на тези 
промени. Системата извежда съответно предупредително съобщение за извършени 
промени, които не са потвърдени или отменени. В този случай преди да напуснете 
страницата, трябва да вземете решение дали да съхраните или отмените промените, след 
което отново можете да натиснете бутона . 

2) Бутонът  съхранява направените от Вас промени, ако има такива; 

3) Бутонът  отменя направените от Вас промени, ако има такива; 
Отмяна може да бъде правена само на промените, които са нанесени на екрана и все още 
не са съхранени в БД. Ако сте направили промени и вече сте ги съхранили в БД чрез 

бутона , тези промени няма да бъдат отменени. В подобна ситуация трябва да 
въведете в полетата на екрана старите стойности и да ги съхраните в БД. 

4) Бутонът  изпълнява действие „Валидиране” на справка 
ПРОДКОМ, при което системата извършва предвидения логически контрол за 
справката; 
При наличие на проблеми системата ще изведе съобщение с кратко описание на 
констатираните при валидирането проблеми. Възможно е да бъдат констатирани 
проблеми от задължителен характер (фатални грешки) и/или от препоръчителен характер 
(предупреждения). При наличие на фатални грешки системата маркира справката като 
„Проблемна”. При липса на проблеми или наличие само на предупреждения системата 
маркира справката като „Валидна”. 

5) Бутонът  визуализира методологическите указания за попълване на 
справката. 
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6) Бутонът  отваря нов прозорец на браузъра, в който са форматирани за 
печат данните от попълнената ПРОДКОМ справка. 
За да прегледате точно, как ще изглежда справката при отпечатване изберете в браузъра 
меню File>Print Preview. В случай на необходимост може да настроите страниците за 
отпечатване като изберете меню File>Page Setup. Тъй като справката съдържа таблица с 
много колони е препоръчително в Page Setup да изберете опция Landscape.  

9.2 Раздел I 

 
Фиг. 41 Изглед на тематична страница „Раздел I” 

Тематична страница „Раздел I” съдържа таблица, която служи за визуализиране, 
въвеждане и редактиране на данни от „Справка за производството и продажбите на 
промишлени продукти”. За извършване на действия в таблицата се използва лентата с 
бутони в горната й лява част: 

Създаването на нов запис в таблицата се извършва чрез бутона . Новият запис след 
натискането на бутона се създава най-отпред в таблицата. 
Изтриването на вече въведен запис в таблицата с данни за производството и продажбите 
на промишлени продукти се осъществява чрез бутона . 
 
Таблицата позволява търсене и филтриране на визуализираните записи. При натискане на 

бутона  се появява допълнителен ред с полета над всяка колона, където може да се 
зададе критерий, според който да се филтрират записите. В полетата за търсене може да 
се задава и само част от търсенето значение, като тогава се извличат само тези записи, 
чиито стойности в съответните полета започват със зададеното значение. При търсене 
може да се използват и релации от вида „>”, „>=”, „<”, „<=”. Критериите за търсене, 
зададени в няколко полета, се изпълняват с логическо „И”. След задаване на стойности в 
полетата за търсене, филтърът се прилага като се натисне клавиша <Enter>. 
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Пример:  
Търсене на записи, чиито код по ПРОДПРОМ започва с 24.10 и чието „Количество” за 
производство общо е >= 5 000,00 

1) В полето за търсене, което е над колоната „Код по ПРОДПРОМ” напишете 
24.10 (не е необходимо да се ползва маскиращ символ %); 

2) В полето за производство – общо количество напишете >=5000; 
3) Натиснете <Enter>. 

 За да извлечете отново всички записи, трябва да изтриете въведените стойности от 
полетата за търсене и да натиснете клавиша <Enter>. 

 
Фиг. 42 Изглед на таблицата за справка ПРОДКОМ с филтрирани записи според зададения горе критерий 

Тъй като таблицата съдържа много колони, в долната и част има хоризонтален плъзгач, 
чрез който могат да се визуализират всички полета за количество и стойност на 
производството и продажбите на отделните продукти или услуги.   
Данните, които се въвеждат в този раздел, са както следва: 
 В полето „Код по ПРОДПРОМ” се въвежда код от „Номенклатурата на 

промишлената продукция ПРОДПРОМ”. Кодът се въвежда ръчно в необходимия 
формат (например 24.20.13.30) или чрез използване на помощен списък, 
визуализиран след натискане на бутона (виж по-долу за подробности). 
 
След попълване на полето с валиден код по ПРОДРОМ, при излизане от полето 
системата автоматично попълва „Наименование на продукта” и „Измерителна 
единица” (в случай, че има дефинирана национална измерителна единица за този 
елемент). 
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Фиг. 43 Помощен списък за избор на промишлен продукт 

Забележка: В помощния списък за избор на продукт от ПРОДПРОМ е необходимо да се 
укаже код на икономическа дейност по КИД-2008 или код на стока от КН, за която да се 
филтрират елементите от класификация ПРОДПРОМ. За целта в съответното поле-филтър 
(виж полетата, заградени горе с червено) трябва да се напише код на икономическа 
дейност (например 24.20) или код на стока от КН (например 73041100) и след натискане 
на клавиша <Tab> системата ще попълни списъка със съответните промишлени продукти. 
Допустимо е в полето-филтър да се въведе и само част от код на икономическа дейност 
или стока от КН. Кодът на икономическата дейност и кодът на стока от КН може да се 
укаже и чрез избор от помощен списък, визуализиран при натискане на бутона до 
съответното поле-филтър. В тези допълнитени помощни списъци може да се извършва 
търсене по код и име (или част от код или име), ако не сте сигурни за точния код или 
наименование.  

 
 Всички полетата за количество и стойност на производството и продажбите се 

въвеждат във формат на дробни числа като се използва символа запетая (,), а не 
точка (.); 
Забележка: В зависимост от типа на продукта и измерителната му единица не се изисква 
въвеждане на количество и стойност за всички полета. В този случай след избор на 
продукт, системата автоматично забранява за въвеждане съответните полета. 

 Полетата за „Продажби (средна цена в левове)” се изчисляват и попълват 
автоматично от системата, като се ползват съответните въведени данни за 
стойност и количество.  
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9.3 Раздели II и III 

 
Фиг. 44 Изглед на тематична страница „Раздели II и III” 

Тематична страница „Раздели II и III” съдържа: 
 Справка за стойността на услуги по производство на ишлеме; 
 Справка за стойността на ненаблюдаваните пром.услуги, които не са ишлеме; 
 Справка за натовареността; 
 Имена и телефон на лицата, отговорни за въведените данни в конкретната 

справка. 
Забележка: Първоначално системата попълва автоматично данните за „Ръководител”, 
„Съставител”, „Лице за контакт” и „Тел. за контакт”. При необходимост за 
конкретната справка тези данни могат да се променят от потребителя. 
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10. Страница „Справка ПРОДЕНЕРДЖИ“ 
Страницата „Справка ПРОДЕНЕРДЖИ” предоставя възможност за въвеждане и 
редактиране на данните от справка за производството и продажбите на енергийни 
продукти. 
Страницата се зарежда за конкретно избран отчет от страница „Работа с отчети”, чрез 
избор на препратката Справка за производството и продажбите на енергийни продукти от 
списъка със справките в отчета. 
Със страницата „Справка ПРОДЕНЕРДЖИ” се работи по аналогичен начин както със 
„Справка ПРОДКОМ“ (виж глава 9. „Страница „Справка ПРОДКОМ” по-горе). 
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11. Приложение: Потребителски интерфейс 
ИС „Бизнес статистика” е реализирана като Web-базирана система. Потребителският 
интерфейс на системата е съчетание от Web-страници и електронни бланки във вид на  
PDF-форми.  

11.1 Web интерфейс 

Във Web-страниците на приложението са използвани различни видове визуални 
компоненти (текстови полета, етикети, combobox-ове, checkbox-ове, таблици и др.) за 
представяне / въвеждане / редактиране на данните. Всяка страница съдържа съвкупност от 
визуални компоненти, обособени в групи. 
Всяко самостоятелно поле в страниците е съчетано с етикет (кратък текст в ляво на 
полето), описващ значението на полето. Когато курсорът е фокусиран в конкретно поле, в 
дясно от полето във вид на tooltip се визуализира по-дълъг текст, описващ значението на 
полето. 
 
Задължителност 
В случай, че дадено поле е задължително за въвеждане, пред етикета на полето е поставен 
символът *, което означава, че данните не могат да бъдат съхранени, ако не е попълнено 
маркираното с този знак поле.  
При определени условия някои полета динамично стават задължителни за въвеждане – в 
този случай полето не е маркирано изрично на екрана със символ, тъй като има случаи, в 
които полето е задължително и случаи, в които не е задължително. При опит да се 
съхранят данните системата визуализира съответното съобщение за непопълнено 
задължително поле или загражда в червена рамка проблемното поле. 
Пример:  

 
 
Ограничения за допустими символи 
В повечето полета трябва да бъде спазен определен формат на въвежданата информация. 
Когато потребителят наруши изисквания формат, при излизане от полето или при опит за 
съхраняване системата загражда с червена рамка проблемните полета или визуализира  
съответни съобщения. Ако на екрана има поле, заградено с червена рамка, можете да 
видите каква е причината за проблема като се позиционирате върху полето, т.е. курсорът 
на текущия фокус трябва да се намира в заградено в червена рамка поле. Когато се 
намирате в проблемно поле, системата визуализира подсказка за това какво е наложеното 
ограничение върху полето, което не сте спазили. 
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Пример: 

 
 
Навигация 
За навигация между полетата в страницата може да се използва клавишът <Tab> или 
мишката. При обхождане с клавиша <Tab> се спазва наредбата на полетата на екрана в 
посока отгоре, отляво-надясно и надолу. При излизане от поле, т.е. преместване на фокуса 
в друго поле, системата извършва валидация на въведената стойност, маркира в червено 
полето, ако има нарушено ограничение и премества фокуса в следващото поле. В този 
случай не се визуализира подсказката на проблемното поле, тъй като фокусът е извън 
него. Ако искате да видите подсказката, трябва да преместите фокуса в проблемното поле. 
Нашите препоръки при въвеждане и промяна на данните в страниците е следната: 
Докато добиете опит в работата със системата използвайте след като сте въвели 
информация в поле клавиша <Enter>, чрез който се извършва валидиране на стойността 
на полето, но фокусът остава в същото поле и веднага се визуализира подсказка, ако има 
нарушено ограничение. Ако полето не се загради с червена рамка или не се визуализира 
съобщение за проблем, тогава въведената информация е коректна и можете да 
продължите в следващото поле.  
 
Компоненти на Web потребителски интерфейс 
В Web-страниците на системата са използвани следните визуални компоненти за 
презентиране на данните: 
 

1) Текстово поле: 

 
Текстовото поле се представя като заграден с тънка черна линия правоъгълник. В площта 
на правоъгълника може да се попълват различни типове данни в зависимост от 
дефиницията на съответното поле. Допустимо е попълването на: 

 Текстови стойности; 
 Числа; 
 Дати. 

В зависимост от данни-типа на полето и допустимия му формат системата може да 
сигнализира на потребителя за недопустими символи или формат. 
 

2) Поле от тип „падащ списък” (combobox): 

 
В този вид полета потребителят има възможност да избере точно един от елементите от 
списъка. 
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3) Поле само за четене: 

 
Това са полета, чието значение се визуализира в страницата като етикет, т.е. статичен 
текст без рамка. Този тип полета не могат да бъдат променяни – за тяхното попълване се 
грижи системата. 
 

4) Поле с помощен списък: 

 
Тези полета са обикновено текстово поле или поле за четене, до което има икона . При 
mouseclick върху иконата се отваря допълнителен прозорец, в който се визуализират 
елементите на свързаната с полето номенклатура: 
Пример: 

 
 
Помощните списъци се използват за намиране на елемент от номенклатура с възможен 
голям брой записи, за чието презентиране не е подходящо поле от тип падащ списък. 
Помощния списък се визуализира в отделен прозорец най-отгоре на страницата. При 
визуализиране на помощен списък страницата, от която е извикан списъкът, става 
недостъпна за работа до затваряне на прозореца на помощния списък. Помощният списък 
съдържа поле за задаване на условие за филтриране, бутон за търсене, таблица с 
намерените резултати и функционални бутони за избор и отказ. 

В полето над таблицата можете да зададете условие за търсене и с помощта на бутона  
да филтрирате елементите, отговарящи на условието. В полето за задаване на условие 
може да напишете само част от търсеното значение на дума. (За подробности виж 4.1 
Секция „Търсене на отчети”). 
От таблицата с намерените резултати изберете конкретен ред (избраният ред се оцветява в 
тъмно син фон) и натиснете бутона „Избери” в долната част на прозореца. Стойностите на 
избраният ред се попълват в свързаното поле от страница, откъдето е извикан помощният 
списък. 
Ако желаете да затворите прозореца без да избирате елемент, натиснете бутона „Отказ”.  
Внимание: Клавишът <Enter> изпълнява действието на бутона “Избери” за текущо 
селектирания ред от таблицата. 
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5) Бутони и препратки 

 

 
Това са компоненти, чрез които се изпълняват специфични за системата програмни 
обработки или се използват за навигиране между страниците в системата. 
 
Внимание: Във всички страници на системата, в които се работи с данни (това са всички 
страници без началната страница и страница „Вход”) НЕ използвайте стандартните 
функции на браузъра (Back, Forward, Refresh, ръчна промяна на URL-адреса и бутончето 
за затваряне в горния десен ъгъл на рамката на прозореца), а използвайте предвидените в 
страниците средства за навигация и препратката „Изход” в горния десен ъгъл на 
страницата. При използване на функциите на браузъра има опасност от загуба на 
последните направени от Вас промени в данните, които не са съхранени, както и от 
заключване на записи с данни в БД. Ако заключите записи с данни, ще трябва да изчакате 
1 час, докато данните Ви се освободят отново за работа. 
Внимание: За визуализиране и работа с електронни PDF-форми (по-голямата част от 
справките в отчета) също се използва браузъра. Всяка PDF-форма се отваря в отделен 
прозорец на браузъра и единственият начин да бъде ЗАТВОРЕНА е чрез бутончето за 
затваряне в горния десен ъгъл на рамката на прозореца (бутончето обозначено с кръстче). 
За повече подробности относно електронните PDF-форми виж следващата точка от 
документа. 
 
Бутоните са представени или като заграден правоъгълник в сив фон с кратко текстово 
значение, или като икона за най-често използваните функции. 

Бутонът  служи за иницииране на операция „Съхраняване на данните в БД”. Всички 
промени, които са направени в данните през страниците на приложението, не се 
съхраняват автоматично в БД. Необходимо е изрично потребителят да стартира действие 
„Съхраняване” и да изчака за потвърждаващо съобщение за успешно изпълнена операция. 

Бутонът служи за иницииране на операция „Отказ от направените промени”. 
Потребителят има възможност да нанесе множество изменения в данните и в даден 
момент да реши да съхрани промените в БД или да се откаже от тях. Този бутон НЕ 
изпълнява действие „Undo” на последната операция. При стартиране на тази операция се 
отменят всички направени промени на данни върху екрана от последното успешно 
съхраняване на данните насам. 
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11.2 PDF-форми 

По-голямата част от справките в годишните отчети са реализирани като електронни PDF-
форми за on-line попълване (само „Справка за предприятието”, „Справка за група 
предприятия”, „Справка ПРОДКОМ“ и „Справка ПРОДЕНЕРДЖИ” са реализирани като 
Web-форми). PDF-формите изцяло наподобяват хартиените формуляри на годишните 
отчети.  
 
Основните типове визуални компоненти в PDF-формите са: 

1) Поле за четене: 

 
Това са полета, в които системата автоматично попълва данни, които се извличат от 
информацията в БД: 
 

2) Текстово поле за въвеждане на данни: 

 
Аналогично на текстовите полета от Web-интерфейса това са полета за въвеждане на 
текст, числа или дати. За всяко поле е дефиниран съответен формат, който трябва да бъде 
спазен. Ако имате включена опция „Highlight Fields” в горния десен ъгъл на toolbar-а на 
Adobe Reader, полетата за въвеждане се оцветяват в светло син фон. В случай, че не е 
разрешено редактиране на справката, всички полета се забраняват за промяна. 
 

3) Помощен списък: 
Аналогично на помощните списъци в Web-интерфейса при необходимост от избор на 
елемент от по-голяма номенклатура в PDF-формите е осигурен помощен списък за избор, 
който се извиква от оцветена в синьо препратка или чрез бутон, оцветен в сиво. Работата с 
помощния списък е подобна на описаната по-горе, като в тези списъци не е осигурен 
механизъм за филтриране. Търсеният елемент се намира визуално и се избира аналогично 
на описаното. 
Пример с препратка: 

 
 
Пример с бутон: 
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Пример за помощен списък: 

 
 

4) Поле с отметка: 
Това са полета с две възможни състояния – включено и изключено: 

 
 

5) Бутони 
Това са компоненти за извършване на програмна обработка с данните в PDF-формата. 
Представляват правоъгълник с черна рамка, оцветен в сив фон, с текстово описание. Във 
всяка PDF-форма в края на справката след всички полета за въвеждане и преди указанията 
са разположени два основни бутона: 

Бутонът  изпълнява действие „Съхраняване” на данните в БД. Всички 
промени, които нанасяте във формата трябва да бъдат съхранени с помощта на този бутон. 
Съхраняването на данните не изпълнява логическите проверки, на които се подлагат 
данните, т.е. можете да съхранявате данните по всяко време, независимо до къде сте 
стигнали с въвеждането. При успешно съхраняване на данните се визуализира съответно 
съобщение.  
Забележка: Съхраняване на данните в БД можете да правите по всяко време, дори и без да 
сте завършили въвеждането на цялата справка. По този начин можете да се предпазите от 
евентуално разпадане на връзката със сървъра и загуба на работата в екрана от последното 
успешно съхраняване насам. 
Забележка: Всички полета от PDF-формите са конфигурирани в базата данни със 
съответен формат, на който трябва да отговарят стойностите им. В PDF-бланката полетата 
също имат дефиниран точен формат за въвеждане. Ако при опит за съхраняване на 
данните системата изведе съобщение, че има форматен проблем с някое поле (например 
въведен е текст в числово поле, а PDF-бланката не Ви е възпрепятствала), то в този случай 
най-вероятно става въпрос за разминаване на конфигурирания формат в БД и този в 
бланката. При подобна ситуация сигнализирайте на посочените адреси за контакт като 
опишете точно проблема и изпратите съобщението за грешка. 
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Бутонът  изпълнява едновременно съхраняване и логическа проверка на 
въведените в справката данни. Валидирането обхваща само логическите проверки, които 
са върху данни само от тази справка. В рамките на целия отчет има заложени също и 
логически проверки между различни справки, които се изпълняват при приключване на 
отчета. Валидирането на дадена справка трябва да се изпълни след като сте преценили, че 
справката е окончателно попълнена. Ако при валидацията на PDF-бланка бъдат 
констатирани проблеми, системата автоматично визуализира диалогов прозорец, 
съдържащ списък на констатираните проблеми. Този диалогов прозорец има само 
информативен характер и след като го прегледате трябва да го затворите, за да 
продължите работата си в справката. Пълният списък на констатираните проблеми при 
валидацията може да намерите в прозореца на браузъра, в който работите с конкретния 
отчет. За да се визуализират в екрана на отчета проблемите на тази справка след нейното 
валидиране, трябва да опресните на екрана данните за отчета (за подробности виж раздел 
4.3.1. „Лента с командни бутони” в глава 4.3. „Секция „Детайли на отчета”). 
Внимание: При работа с PDF-форма не забравяйте да съхраните данните изрично преди 
да затворите прозореца. Прозорец с отворена PDF-форма се затваря с помощта на 
бутончето за затваряне на прозорец, което се намира в горния десен ъгъл на рамката на 
прозореца (бутончето обозначено с кръстче). При затваряне на прозореца системата не 
предупреждава потребителя за извършени промени, които не са съхранени! 
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11.3 Съхраняване на съдържанието на отчети локално на 
компютъра 

Копия на попълнените справки от отчета могат да бъдат съхранявани като файлове 
локално на Вашия компютър. Тази функционалност е налична от началото на 2013 г. за 
новите отчети (отчетите от ГОД-2012 включително нататък). Тази функционалност НЕ е 
налична за по-старите отчети. 
Съхраняването във вид на файл на съдържанието на справка, която е реализирана в 
системата чрез PDF-форма, се извършва чрез бутона Save на Adobe Reader (бутонът с 
дискетката в tollbar-а под заглавието на прозореца, в който е отворена справката):   
 

 
Фиг. 45 Локално съхраняване на справки, реализирани като PDF-форми 

По този начин могат да се съхраняват както справките, реализирани като PDF-форми за 
въвеждане, така и справките, които са реализирани чрез Web-форми за въвеждане, но се 
генерират за разпечатване като PDF-форми (напр. „Справка за предприятието” и 
„Справка за група предприятия”). Останалите справки (тези, които се въвеждат чрез Web-
форма и се генерират за разпечатване във формат HTML, напр. „Справка ПРОДКОМ” и 
„Справка ПРОДЕЖЕРДЖИ”) могат да се съхранят във файл във формат HTML от менюто 
File -> Save As на браузъра. 
Съхраняването се извършва справка по справка, т.е. не може всички справки от отчета да 
се съхранят на локалния компютър наведнъж. 
Важно: Локално съхранените копия на справките НЕ могат да бъдат редактирани и/или 
подавани по-късно към системата (т.е. това не е функционалност за работа в режим off-
line, а е само възможност за поддържане на архив на подадените отчети локално на Вашия 
компютър).  
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12. Въпроси и проблеми 
При констатиране на проблеми при стартиране на системата, проблеми при работа със 
системата или ако имате допълнителни въпроси, моля обръщайте се към вашите 
Териториални статистически бюра или на следните e-mail адреси: 
 За технически проблеми или въпроси – isbs_tech@nsi.bg  

 За методологически проблеми или въпроси – isbs_stat@nsi.bg 
 


